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Chapter 1 

Introduction
 SierraFC M164 Protocol Analyzer User Manual 11

This manual describes installation and operation of the LeCroy 
SierraFC M164™ Fibre Channel Protocol Analyzer and includes examples of typical 
applications.

Figure 1.1: LeCroy SierraFC M164 Protocol Analyzer

Analyzer Overview

The SierraFC M164 Protocol Analyzer helps Hardware, Firmware, Design, and Application 
Engineers troubleshoot and diagnose problems within their product. The analyzer 
supports capturing, triggering, and filtering.

The Analyzer provides for bi‐directional trigger and capture of exchanges, primitives, and 
patterns. You can capture all frames and/or exclude traffic. 

The Analyzer has a USB port and an Ethernet port to connect to a computer. You can 
cascade analyzer units for higher port counts. You can trigger manually or trigger on a 
specific Event.

The Analyzer provides a full range of views and statistical reports.



LeCroy Corporation
Receiving Your Analyzer

The analyzer package includes the following components:

 SierraFC M164 Analyzer identified in the packing list
 SierraFC M164 Quick Start
 USB A‐B 2.0 cable, 1.8 meter
 Ethernet cable, 10 feet
 Three‐Prong AC power cord
 Rack Mount and Rack Mount Installation Guide
 Installation CD ROM with software and documentation

Unpacking the Analyzer

Inspect the received shipping container for any damage. Unpack the container and 
account for each of the system components listed on the accompanying packing list. 
Visually inspect each component for absence of damage. In the event of damage, notify 
the shipper and LeCroy Corporation. Retain all shipping materials for shipper’s 
inspection.

Analyzer Features

The Analyzer has the following features:

 Power Switch
 Trigger, Error, Link, Speed, and Frame LEDs (see next page)
 Port 1 connector
 Port 2 connector
 Port 3 connector
 Port 4 connector
 Status and Configuration LCD Display
 Configuration Buttons
 Front Panel Configuration Buttons
 External Trigger Input and Output
 USB port for host connectivity
 Ethernet port for network connectivity
 19‐inch Rack Mountable. Refer to the Rack Mount Installation Guide.

Figure 1.2: Front Panel
12  SierraFC M164 Protocol Analyzer User Manual
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On the back, the Analyzer has:

 Power In
 STX SYNC Expansion Card In/Out data ports (optional)

Figure 1.3: Back Panel

LEDs

LEDs support each port link, with the following functionality (refer to Figure 1.4 on 
page 13):

Trigger Illuminates when a trigger occurs.
Blue

Error Illuminates when an error occurs.
Red

Link Illuminates when a link is established.
Yellow

Frame After the link is established, indicates traffic on the bus.
Green

There are five LEDs on the left of the analyzer for ports P1 and P2, and five LEDs on the 
right of the analyzer for ports P3 and P4. These 10 LEDs indicate the speed of 1Gbps, 
2Gbps, 4Gbps, 8Gbps and 16Gbps. Speed LEDs are off when there is no link (see the 
following figure and Figure 1.2 on page 12).

Figure 1.4: LEDs on the Left Front Panel
    SierraFC M164 Protocol Analyzer User Manual 13
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Figure 1.5: LEDs on the Right Front Panel

Status and Configuration Display

The Analyzer front LCD display indicates the configuration and status of operations. For 
example, during initialization, the LCD panel displays boot status messages.

LCD Display and Button Functions for Configuring the Analyzer

The SierraFC M164 can be configured from the unit itself. Five buttons are provided to 
enable you to configure the Analyzer. When you first turn on the Analyzer, after 
initialization, the LCD displays SierraFC_M164 Available with two arrows pointing up and 
down as shown in the illustration below.

Figure 1.6: LCD Display and Button on the Front Panel

When connected via ethernet or USB, the Up and Down buttons display the 
following:

 Static or Dynamic IP Address
 SierraFC_ M164 SN
 Connection 
 Unit Name
 Set IP Configuration
 IP Mode Dynamic, or
 IP Mode Static

SierraFC_M164

Available

Up Button

Down Button

Left
Button

Right
Button

LCD Display
Center Button
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The Left  and Right  buttons are used to change the configuration properties.
The LCD will display Button Inactive In This MenuItem if the button does not serve any 
purpose for that selection.

Perform the following steps to set IP Configuration, Static on Dynamic IP using the 
buttons and the LCD display on the Analyzer:

Set IP Configuration

To set IP Configuration:

1. Press the Up Button once to get into the Set IP Configuration mode.

2. Press the Center Button once to select Set IP Configuration.

Set IP Mode Static is displayed in the LCD display. If you do not want to set IP Mode 
Static, press the Up Button to set the IP Mode Dynamic, see “IPMode Dynamic” on 
page 15).

3. Press the Center Button once to select Set IP Mode Static.

The Static IP address (for example: 188.168.040.036) is displayed in the LCD display.

4. Press the Center Button once to set the Static IP address.

The first numeral of the IP address will start blinking.

5. Use the Up Button or Down Button to change the IP Address.

6. Press the Right Button or Left Button to move to the right or left to change each 
component of the static or dynamic IP adress and change it using step 5.

7. Once the IP Address is set, press the center button to select it.

8. Press the Up Button once to Accept and Reboot.

9. Press the Up Button once Cancel the Changes.

10. Press the Up Button once to set the Gateway address. Repeat steps 4 through 9 to 
set the Gateway address.

11. Press the Up Button once to set the Subnet Mask address. Repeat steps 4 through 9 
to set the Subnet Mask address.

12. Press the Up Button once to set the Static IP address. Repeat steps 4 through 9 to 
set the Static IP address.

13. Press the Center Button once to confirm reboot. The LCD display will read Center 
Button to Confirm Reboot.

14. The Analayzer will reboot. The LCD display will display the new IP Configuration.

IPMode Dynamic 

Perform the following steps to set IP Mode Dynamic on the Analyzer:

1. Press the Up Button once to get into the Set IP Configuration mode.

2. Press the Center Button once to select Set IP Configuration.

Set IP Mode Dynamic is displayed in the LCD display.

3. Press the Center Button once to select Set IP Mode Dynamic.
    SierraFC M164 Protocol Analyzer User Manual 15
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The Dynamic IP address (for example: 188.168.040.036) is displayed in the LCD 
display.

4. Press the Center Button to select it.

5. Press the Up Button once to Accept and Reboot.

6. Press the Up Button once Cancel the Changes.

Installing Your Analyzer

Software Installation

The software works on systems using the Windows® XP, Windows Vista, Windows Server 
2003, 2008 and Windows 7 operating systems.

1. Insert the Installation CD‐ROM into the CD drive on the host machine.

2. The installation automatically starts setup, unless Auto Run is off. In that case, select 
the CD‐ROM from “My Computer” and click Setup.

3. After the warning to close all other programs and before starting the installation, 
the Install component selection opens.

4. Select components for installation.

5. Click Next to complete the installation.

System restart

You must restart your computer before you can use your Analyzer software.

Error Message

If you get an error message during installation of the drivers for Window, consult your 
system administrator. Your system may allow only administrator‐level users to copy such 
driver files.
16  SierraFC M164 Protocol Analyzer User Manual
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Hardware Setup

The hardware setup is described below.

Connecting in General

Note:You must install the software before connecting the analyzer to the host machine for the first 
time.

To set up the analyzer:

1. Connect the analyzer to a 100V–240V, 50Hz–60Hz, power outlet and turn on the 
Power switch.
At power on, the analyzer will go through initialization as shown on the LCD display.

2. Connect the USB cable between the SierraFC M164 USB port and a USB port on the 
Host PC. The host PC operating system detects the analyzer and driver files.
(See “Connecting via Ethernet” on page 26 for Ethernet connectivity.)

3. Connect the analyzer as shown in the following figure. The figure shows one 
possible connection from an Initiator to a hard drive.

Figure 1.7: Analyzer Connections
    SierraFC M164 Protocol Analyzer User Manual 17
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Cables to Use

Connect from Hard Drives using SFP and a cable suitable for your setup. 

Connect from Initiators using SFP and a cable suitable for your setup. 

Figure 1.8: Analyzer Connections

Expandability

You can expand by:

 Cascading with CATC SYNC Expansion Cards 
 Using the Power Expansion Card (optional) 

You can remove expansion cards with two simple tools.

Removing Expansion Cards

You can remove expansion cards using two tools:

 Standard (flat blade) 3/16” screwdriver
 LeCroy Extraction Tool (part number 230‐0160‐00

To remove an expansion card, follow these steps:
18  SierraFC M164 Protocol Analyzer User Manual
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1. Unplug the system from AC power and turn the system so the expansion port is 
facing you. Note the two retaining screws and the holes for the extraction tool that 
are located on the panel of the expansion card.

2. Insert the extraction‐tool prongs into the holes in the expansion card panel.

Note: If the prongs do not slip easily into the holes, use a small nail file or similar device to remove 
paint from the prongs

3. Rotate the extraction tool to a horizontal position to lock the prongs into place and 
make a handle

Holes in the 
Expansion Card
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4. Using the screwdriver, loosen both retaining screws by rotating them counter‐
clockwise approximately two full turns, until feeling slight resistance. Do not force 
the retaining screws after two turns.

5. Using the extraction tool as a handle, gently wriggle the expansion card forward 
about 1/8”.

6. Repeat steps 4 and 5 approximately three times, until the card is free from the 
retaining screws and you can remove the card from the system.
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Cascading with CATC SYNC Expansion 

You can use cascading of analyzer units for higher port count, by connecting the units 
through the optional CATC SYNC Expansion Card on the analyzer back.

Connecting a SierraFC M164 and a Summit T3-16 via the CATC Sync Expansion Card 
(ACC-EXP-002-X)

A SierraFC M164 and a PCIe Summit T3‐16 are connected using their CATC Sync ports 
which require an optional expansion card (ACC‐EXP‐002‐X).

Note:Refer to relevant protocol analyzer user manual for instructions on how to install the expansion 
board.

To do so perform the following steps:

1. Make sure to stop any recordings in progress.

Note:You may plug/unplug the sync cable while the analyzer unit is powered on.

2. Connect the female end of the sync cable to the SYNC OUT port of the SierraFC 
M164.

3. Connect the male end of the sync cable to the SYNC IN port of the PCIe Summit 
T3‐16.
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Figure 1.9: An Example of Connecting a SierraFC M164 and a Summit T3-16
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Select Device 

After you start the software, click on Configuration and select All Connected Devices (see 
the following screen capture).

Figure 1.10: Connecting to Device(s)

The following Select Device dialog displays. The colors in the ‘Location’ column mean the 
following:

 Red: Firmware and/or BusEngine components need to be updated to the latest 
version

 Light Blue: The device is ready to be connected.
 Yellow: The device is not chained or cascaded.
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Figure 1.11: Select Device Dialog

Note:Click Refresh Device List to display all the devices on the network.

The Select Device dialog displays the following buttons:

Set Alias Name

Click Set Alias Name to display the Set device alias name dialog as shown below.

Figure 1.12: Set Device Alias Name Dialog

Disconnect

Click Disconnect to disconnect a device.

Add Device...

Click Add Device to add a device with a static IP address.

Figure 1.13: Add Device with Static IP Dialog

Remove Device

Click Remove Device to remove a previously added device.

IP Settings...

Click IP Setting to reset IP settings of a device. The following IP Setting dialog displays.

Figure 1.14: IP Setting Dialog
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Networks...

Click Networks to select an adapter. The following dialog displays.

Figure 1.15: Select Adapter Dialog

Refresh Device List

Click Refresh Device List to refresh the device list.

To connect to a device, select a device which is Ready to Connect and click the Connect 
button on the right. The Connection Properties dialog is displayed (see the following 
screen capture).

Figure 1.16: Connection Properties Dialog

Specify one of the actions from the following:

 Automatically connect to the device
 Ask if I want to connect to the device
 Take no action

If ‘Automatically connect to the device’ is selected, the next time the application opens 
the device will be automatically connected.
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In the Select Device dialog chained or cascaded units are displayed in the Device column 

with a [ (square bracket) icon. The sequence of the units is displayed in the Order 
column. See the following screen capture.

Figure 1.17: Select Device Dialog Displaying Unit 1 and Unit 2 Chained

Note:When using STX Sync cards, you need to manually specify the order of the chained units. To 
match your unit sequence to the address for each unit in the Select Device dialog, click the 
pull down tab under the Order heading (on the right side) and select unit numbers: 1 for 
Unit 1, 2 for Unit 2, and so on. This determines the order in which the cascaded ports appear in 
the trace. When using the CATC Sync cards the order is automatically detected.

IMPORTANT! Power up all units before starting the software.

Connecting via Ethernet

The Ethernet connection can have any of these configurations:

1. Analyzer connected to a network using a hub, switch, Gigabit Ethernet interface, or 
similar device.

2. Analyzer connected to the host computer (machine running the application 
software), using a hub, switch, Gigabit Ethernet interface, or similar device.

3. Analyzer connected directly to the host computer using an Ethernet cable. 

Connecting to a Network

When connected to a network, the analyzer can communicate with the DHCP server to 
establish a connection. The DHCP server continually sends the next available IP address 
to the analyzer until the software starts. 

The SierraFC M164 product uses the following ports:
TCP Ports: 4000 ‐ 4003

UDP Ports: 4027 ‐ 4029
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Connecting using a Hub, Switch, or Similar Device

When connected to the host machine using a hub, switch, Gigabit Ethernet interface, or 
similar device, the Analyzer must be given a static IP address such that it will reside on the 
same subnet as the host computer. See Figure 1.14 on page 24 to set the IP address. To 
add the IP address to the Select Device dialog, use the Add Device button (see Figure 1.13 
on page 24).

Analyzer Connected Directly to the Host PC Using a Ethernet Cable

When connected to the host machine using a crossed ethernet cable, the Analyzer must 
be given a static IP address such that it will reside on the same subnet as the host 
computer. See Figure 1.14 on page 24 to set the IP address. To add the IP address to the 
Select Device dialog, use the Add Device button (see Figure 1.13 on page 24). 

Connecting Over Different Subnets

If the Host PC (with the Sierra software) and SierraFC M164 are on the same subnet, they 
will see each other’s broadcasts, and the SierraFC M164 application will automatically 
appear in the Select Device dialog, from which you can select a device (as described in the 
previous section).

If the Host PC and SierraFC M164 do not reside on the same subnet, they will not see 
each other automatically. You must add the SierraFC M164 IP address manually. To add 
the IP address, use the Add Device button (see Figure 1.13 on page 24). 

Connecting Via USB

To set up the Analyzer using a USB connection: 

1. Remove the Analyzer from its shipping container. 

2. Insert the Installation CD. 

3. Connect the Analyzer to a power outlet using the provided power cord. 

4. Connect the USB port to a USB port on the PC using a USB cable. 

5. Turn on the rear power switch and the front power switch. 

6. Click Next after you see the Add New Hardware Wizard window. 

7. Follow the Microsoft® Windows® on‐screen Plug‐and‐Play instructions for the 
automatic installation of the Analyzer as a USB device on your PC. (The required USB 
files are included on the Installation CD.)

8. Click Finish when you see the message that says “Windows has finished installing 
the software that your new hardware requires” and the file has been installed in 
your PC. 

Do not change from USB to Ethernet, or back, without power cycling the Analyzer.

To connect the Analyzer to a host system via ethernet, refer to“Connecting the SierraFC 
M164 to a Host System Over Ethernet” on page 229.
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Launching Your Analyzer

To launch the software, double‐click the FC Icon in the Program Manager Window.

Click OK to display the software.

Operating in Simulation Mode

The system operates in Simulation Mode by default if the software detects no hardware. 
However, you can operate in Simulation Mode directly, without installing the Analyzer 
hardware. 

The Analyzer software launches and displays the appropriate tool bar, but with the 
limitation that the Analyzer operates only on static, previously captured, bus data.

Limitations

Simulation Mode lets you try all of the available functions, but the system is not 
capturing any real data and is displaying only pre‐captured results.

Using the Software

The SierraFC M164 application has protocol analysis software to capture data, trigger on 
Events, and save. Easy Mode allows standard Trigger and Data capture. Advanced Mode 
(see figure below) allows you to program custom triggering in and out, capturing, state 
jumps, and timers. (See “Protocol Analysis” on page 33.)
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Figure 1.18: Easy/Advanced Mode Toggle Button

Easy, switch to Advanced Mode 
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Protocol Analyzer

To use the software for protocol analysis (see  on page 29), first select File > Protocol 
Analyzer for a new project or File > Open an existing protocol analysis .fcc file. (See 
“Protocol Analysis” on page 33.) You can also open a .fcs example file. Example files are in 
the Examples folder. You can also use Project Setup > Last Protocol Analyzer.

In Easy Mode, on the Capture tab, select to capture Everything or Pattern. For Pattern, 
select a Pattern. You can exclude patterns and frames. You can do this by dragging 
patterns from the Patterns Library pane into the Active pane. You can use different 
patterns for pre‐trigger and post‐trigger.

In Easy Mode, on the Trigger tab, select the trigger type. For Pattern, select the pattern.

In Easy Mode, on the Settings tab, select trigger position and memory use. 

Change the Analyzer settings if necessary. Change the port Speed if necessary.

Use Advanced Mode only after you become familiar with the hardware and software and 
have special needs. To start working with the protocol analyzer and software. See 
“Protocol Analysis” on page 33.

Viewing Captured Data

After data capture, the captured data is in the Viewer, see “Display Manipulation” on 
page 161. You can display the same data in:

 Spreadsheet View: Shows Protocol Fields and Frames by time.
 Frame Inspector View: Shows detail information about packet highlighted in 

Spreadsheet or Packet views.
 Packet View: Shows hierarchical view of frames, sequences and exchanges.
 Text View: Shows transaction frames, grouped in columns by port.
 Statistical Report View

You can do the following:

 Show or hide fields and ports, change port names, and change data format.
 Show the layers and channels using their toolbars.
 Decode using the Decode toolbar.
 Search and Filter.

Configuration

For special work, you can use the Configuration menu to configure Port Alias, External 
Trig Setting, Software Settings, and Input/Output Signals. (“Display Manipulation” on 
page 161.)

Port Status

You can display an overview of the active ports by clicking the buttons at the bottom right 
of the main window (see “Port Status” on page 179).
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Statistical Reports

You can generate statistics for all transports, commands, primitives, addresses, lanes, and 
errors (see “Statistical Report” on page 187).

CrossSync Control Panel

The LeCroy CrossSync control panel provides synchronization for complete end‐to‐end 
visibility into multi‐protocol systems. 

CrossSync is LeCroy’s analyzer synchronization solution that enables time‐aligned display 
of protocol traffic from multiple daisy‐chained analyzers showing packet traffic from 
multiple high‐speed serial busses. A lightweight software control panel allows users to 
select analyzers for synchronization and manage the recording process. Captured traffic is 
displayed using the latest analyzer software (in separate windows) with all the protocol 
specific search and reporting features.

Captured packets are displayed in separate windows that share a common time scale. 
Navigating the traffic in either direction will scroll to the same timestamp in a 
synchronized window. When using the CrossSync option, users can access the full 
complement of analysis capabilities available within the individual LeCroy software. 
Search, reporting, and decoding all operate normally (see “CrossSync Control Panel” on 
page 31). 

This feature is available with the LeCroy SierraFC Fibre channel Protocol Suite application.
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Chapter 2 

Protocol Analysis
The system performs Protocol Analysis by defining and running an analysis project. An 
analysis project definition defines what to capture, what the analyzer triggers on, and the 
memory settings. You can save defined projects as project *.fcc files for later use.

Easy Mode (Pre-Defined Setups)

After you install the Analyzer software (see “Software Installation” on page 16) and set up 
the Analyzer (see “Hardware Setup” on page 17), launch the Analyzer software (see 
“Launching Your Analyzer” on page 28) to display the default Protocol Analyzer in Easy 
Mode at the Capture tab.

This mode allows you to operate the analyzer with minimum setup. In this mode, you can 
perform only a Trigger and Data capture.

Main Window

Use Easy Mode to get a comprehensive overview of your analyzer’s capabilities:

On the Analyzer Menu Bar, click File > Protocol Analyzer to open a Protocol Analyzer 
dialog.
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Figure 2.1: Protocol Analysis Project Dialog

The New Project dialog opens with default settings to capture Everything on the bus and 
to Trigger On on Snapshot. (The analyzer captures everything immediately without 
triggering on anything in particular).

Analyzer Settings

Buffer Size and Segments

The Analyzer Settings tab has the Recording Buffer pane where you can set Number of 
Segments and the Segment Size. (See “Buffer Size and Segments” on page 152.)

Trigger Position

You can set the trigger position in the captured buffer as a percentage of the segment 
size. Trigger point of 0% means the trigger point will be on the first packet in the buffer. 
(See “Trigger Position” on page 152.)

 
 

What analyzer triggers on

Project Overview Pane

Collapse All Button: hides 
details in Project Overview

Expand All Button: shows 
details in Project Overview

Capture Memory Settings
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Auto Run

Checking the Auto Run option allows you to specify the number of concurrent runs that 
will be automatically carried out. (See “Auto Run” on page 152.)

Training Signal Pack Mode

This options provides two modes for training signals.

 Unpacked
 Packed

Analyzer Settings

You can enable the ports, set the port speed and disable scrambling.

Disabling a port can be used to save recording buffer space. A disabled port can still 
trigger the analyzer.

Auto Speed is the default port speed selection. It will automatically detect and display the 
line speed. In rare cases (such as debugging speed negotiation), it might be desired to set 
the analyzers speed manually. Note, that when the speed is set manually, traffic at 
different speeds will not be captured correctly.

Set Protocol Error Detection

You can select which Protocol Errors the analyzer will show and which will be ignored.

Project Overview

The Project Overview on the right side of the main window displays a comprehensive tree 
structured overview of the project. The project tree shows what to capture, on what the 
analyzer triggers, and the capture memory settings.

Capture Tab

The Capture tab allows you to set the parameters for capturing patterns. The Capture 
dialog box opens with default settings to capture Everything on the bus. The analyzer 
captures everything immediately without triggering on anything in particular.

You can drag and drop patterns from the Patterns Library pane into the Active Pane. You 
can select the pattern and use the Add and Remove arrows to move patterns between 
the Patterns Library and the Active pane.

Note:Capturing a 16GB trace requires you to capture the traffic with both ports (P1, P2 & P3, P4), 
otherwise, only an 8GB trace is captured.

Truncate Payload

Check this option to truncate payload after x‐number of Dword(s). 
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Figure 2.2: Capture Dialog

Parameters

The Capture tab has the following parameters. See Figure 2.3 on page 37.

Exclude Idle
Check this to exclude Idles from the data capture.

Exclude RRDY
Check this to exclude RRDY primitives from the data capture.

Exclude Training Pattern
Check this to exclude Training Pattern primitives from the data capture.

Exclude ARBff
Check this to exclude ARBff primitives from the data capture.

Exclude NOS
Check this to exclude NOS primitives from the data capture.

Include and Exclude 
arrows
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Exclude traffic till both ports are up
Check this to exclude traffic till both ports are up.

Use separate patterns for Pre‐ and Post‐triggers captures replaces the Capture tab with a 
Pre‐Trigger Capture tab and a Post‐Trigger Capture tab.

Figure 2.3: Protocol Analysis Capture Dialog

Software Menus and Toolbar

The software has the following main toolbar. 

Figure 2.4: Main Toolbar

Run Hardware

To get an immediate overview of the bus traffic to and from your Analyzer:

1. Click the   Record button.

2. The analyzer begins filling the defined memory buffer with traffic on the bus. After 
the traffic fills the memory buffer, the traffic is uploaded to the viewer and all views 
are displayed, except the Statistical Report View. 

 
 

                     Open Sample File

Run Last Open Capture Project

Abort Capturing Without Saving Sample File

                  

Toolbar Options 

Stop Hardware

Upload Manager Show Port Configuration
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3. Spreadsheet View is the default display. However, you can view results in any of the 
different views by selecting View on the menu bar and choosing the desired View. 
Note: the software remembers the last view (or views combination) used, and will 
automatically use that next time it is launched.

4. How to add additional buttons need to add to 4. You can add additional keys to the 
view panel. Please follow the steps:

Figure 2.5: Typical Spreadsheet View Results Display

The results display shows each transaction for every layer identified in a different color 
and the data direction identified with data direction arrows. Upstream traffic has an 
arrow from right to left:. Downstream traffic has an arrow left to right: .

You can hide any layer by clicking the corresponding Show/Hide button on the menu bar. 
The system retains all captured data, but the display has only some data layers for simpler 
viewing.

You can configure the viewer display for test and viewing preferences (see “Viewer 
Display” on page 161 for details about configuring the viewer display).

The Analysis Project dialog offers you a comprehensive set of choices to create a trigger 
and capture project satisfying some specific need. You can set the Analyzer to:

 Capture specific patterns (see “Patterns and Data Capture Setup” on page 42).
 Capture different patterns pre‐ and post‐trigger (see “Patterns and Data Capture 

Show/Hide Protocol LayersX,Y,T Cursors Show/Hide port data

Data direction arrows

Relative time display (Between two sequential 
packets on the same layer and port)
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Setup” on page 42).
 Exclude parameters from capture (see “Patterns and Data Capture Setup” on 

page 42).
 Trigger on a pattern or sequence of patterns (see “Trigger Setup” on page 131).
 Configure trace capture memory (see “Project Settings” on page 159).
 Select file to save trace capture in memory (see “Project Settings” on page 159).
 Include a project note (see “Notes” on page 159).

Saving a Trace Capture

You can save a Trace Capture for review at a later time using the Save As dialog. 

Figure 2.6: Save As Dialog

You can limit the range of the saved file. You can save:

 All Traces
 A range between selected cursors
 A range between selected level of decoding. The levels allowed are dependent 

on the traffic in the trace. A trace with only Switch traffic might have the follow‐
ing levels available: ELS Cmd, Frame, GS Cmd, Sequence and SW Cmd, whereas a 
read‐write trace might have Frame, SCSI Cmd and Sequence available.

Save Filtered Sample checkbox saves a trace file without filtered data.
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CrossSync Control Panel

The CrossSync Control Panel allows you to select analyzers for synchronization and 
manage the recording process.

Launching the CrossSync Control Panel

To launch CrossSync from the FC Protocol Suite software application, select the ‘Launch 
CrossSync Control Panel ‘entry in the ‘Project Setup’ menu (see the screen below). Or, 
you can launch CrossSync from the ‘Start’ menu.

Figure 2.7: Launching CrossSync from the SierraFC M164 Protocol Suite Application

Please refer to the CrossSync Control Panel User Manual for more information.

Projects

You can define a new project, starting with the default project definition, or modify the 
settings for the last project run.

New Default Project
To start a New project, select File on the main menu bar and choose Protocol Analyzer to 
open a new project with default settings that you can modify (see “Main Window” on 
page 33).

Last Project

Clicking the Green button  opens the last project run, so you can modify it.

Project File Types

Projects have the following file types:

 *.cfgDisplay Configuration file (in the System folder “Config” subfolder)
 *.fccProtocol Analyzer/Capture Project/Viewer file
 *.fcsSample file
 *.wsfWorkspace file
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Example Projects

The Analyzer includes example projects that you can use to perform an immediate 
analysis without any setup.

The Analyzer system software has a pre‐defined folder (directory) structure for storing all 
files. All example files are in the Examples folder under the SierraFC M164 folder.

It is strongly recommended that you open some example files to see types of projects 
that you can create.

Run an Example Analysis Project

To run an example project:

1. Select File > Open.

2. Locate example analysis projects by looking in the Examples folder. Examples are 
available for AdvanceCaptr, EasyCaptr, and Samples.

3. In the Samples folder, choose an example *.fcs file and click Open to display the 
example project dialog.

Figure 2.8: Open File Dialog

4. Click the Record button to execute the pre‐defined example.
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5. After the project runs, you see an analyzer trace capture display. 

Figure 2.9: Analyzer Trace Capture Display

For details about the results display, see “Display Manipulation” on page 161 and see 
“Display Configuration” on page 217.

Patterns and Data Capture Setup

You can refine data capture by choosing Pattern and then selecting specific patterns for 
capture. Additionally, you can define a different set of patterns to capture after trigger.

To define specific patterns for capture, click the Pattern button to display the Capture tab 
for Pattern. You can drag and drop patterns from the Patterns Library pane into the Active 
Pane. You can select the pattern and use the Add and Remove arrows to move patterns 
between the Patterns Library and the Active pane.
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Figure 2.10: Choosing Capture Patterns

Choose a Parameter

To choose a parameter for capture from any of these categories, highlight the category in 
the parameter window and click the +>> button to add the selection. You can also drag 
and drop a pattern. This opens selection dialogs for each of the categories displaying all of 
the parameters for that category. All patterns added appear in the Project Overview.

Include Patterns

This is the default selection. Check this box to allow for the capture of the patterns that 
have been added to the Project Overview. When you Include Patterns, only those 
patterns will be recorded, thus saving buffer space and emphasizing only what the user 
needs. However, to get proper context, you would typically need to include a lot of 
Patterns. To Exclude only unwanted Patterns is another option.

Add and 
Remove 

arrows
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Exclude Patterns

Check this box to allow for the capture of everything except the patterns that have been 
added to the Project Overview. 

When you check the Exclude Patterns box, the Ordered Set category appears in the 
Pattern List, and the Exclude Idle item appears in the Project Overview under the 
Capture (Exclude) branch. 

Figure 2.11: Exclude Patterns Checked

To remove an item from capture, highlight it in the Project Overview and click the ‐<< 
button.
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Pre- and Post Trigger Data Capture

You can define one set of patterns for capture prior to the occurrence of a trigger and 
another set of patterns for capture after the occurrence of a trigger. The selection and 
setup procedure is the same for both Pre‐Trigger capture and Post‐Trigger capture. 

Check Use separate patterns for Pre‐ and Post‐trigger captures to enable the Pre‐Trigger 
Capture and Post‐Trigger Capture tabs (instead of only the Capture tab).

Figure 2.12: Pre-Trigger and Post-Trigger Capture Dialog Enabled

Defining Patterns

To select an item for capture, either highlight the category and click the +>> button, or 
double‐click the category, to open a corresponding definition dialog. 

You can define patterns for specific ports by checking or unchecking the Port ID.

Check box for Pre- and 
Post trigger captures
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Basic Patterns

Connect/Disconnect

Double‐click Connect/Disconnect to open the Add Connect Disconnect Pattern dialog.

Figure 2.13: Connect Disconnect Pattern Dialog

Check Connect and/or Disconnect.
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Ordered Set 

Double‐click Ordered Set to open the Add Ordered Set Pattern dialog. 

Figure 2.14: Ordered set Pattern Dialog

To select an Ordered Set, click the dropdown list. You can choose NOT to trigger on 
anything that is NOT the defined pattern. You can choose Frame Delimiters, Primitive 
Signals, or Primitive Sequences. 

Note:The Symbol pattern is only available on the Trigger tab, and when using the Ordered Set pattern, 
only the Exclude option is available.
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Basic Link Service

Double‐click Basic Link Service in the Pattern window to open the Add 
Basic Link Service Pattern dialog.

Figure 2.15: Basic Link Service Pattern Dialog

The format can be Binary or Hexadecimal.

To select a Basic Link Service, click the dropdown list.
48   SierraFC M164 Protocol Analyzer User Manual



Easy Mode (Pre‐Defined Setups)     LeCroy Corporation
Link Control Frame

Double‐click Link Control Frame in the Pattern window to open the Add Link Control 
Frame Pattern dialog.

Figure 2.16: Link Control Frame Pattern Dialog

The format can be Binary or Hexadecimal.

To select a Link Control Frame, click the dropdown list.

Symbol 16G

The Symbol 16G cannot be added as a Capture Pattern. 

Training Sequence

The Training Sequence cannot be added as a Capture Pattern. 

Capture (Filter Out)

Exclude Training Sequence.
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FCP Patterns

FCP SCSI Command

Double‐click FCP SCSI Command in the Pattern window to open the Add 
FCP SCSI Command Pattern dialog.

Figure 2.17: FCP SCSI Command Pattern Dialog

The format can be Binary or Hexadecimal.

If you select Any SCSI Command, the Command Type can only be Any Command. Click 
the down arrow next to the CDB dropdown list, scroll the list to choose a CDB Type, and 
click OK. The Any option allows specifying any vendor‐specific or other command. 

If you select MMC‐6, SBC‐3, SMC‐3, SPC‐4, SSC‐2, OSD‐2, or ADC‐3, click the down arrow 
next to the Command Type dropdown list, scroll the list to choose a Command Type, and 
click OK.
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FCP Frame Information Unit

Double‐click FCP Frame Information Unit in the Pattern window to open the Add 
FCP Frame Information Unit Pattern dialog.

Figure 2.18: FCP Frame Information Unit Pattern Dialog

The format can be Binary or Hexadecimal.

To select a Frame Type, click the dropdown list. On selecting a Frame Type the Parameters 
and Value of that Frame Type are displayed.
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SCSI Command Status

Double‐click SCSI Command Status in the Pattern window to open the Add SCSI 
Command Status Pattern dialog.

Figure 2.19: SCSI Command Status Pattern Dialog

You can capture on Status Only or Sense Key/Response Code. Click on Status Only to 
display all the states that are available. Click on the Sense Key/Response Code to display 
all the Format and Sense Keys.

RSP_CODE: It is selected by default. You can click on the dropdown list to select more 
options.
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FCP Task Management

Double‐click FCP Task Management in the Pattern window to open the Add 
FCP Task Management Pattern dialog.

Figure 2.20: FCP Task Management Pattern Dialog

The format can be Binary or Hexadecimal.

To select a Function, click the dropdown list.
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ARB Patterns

ARB Loop Initialization

Double‐click ARB Loop Initialization in the Pattern window to open the Add 
ARB Loop Initialization Pattern dialog.

Figure 2.21: ARB Loop Initialization Pattern Dialog

The format can be Binary or Hexadecimal.

To select a Loop Init ID, click the dropdown list.
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ELS Patterns

Extended Link Service ‐ Request

Double‐click Extended Link Service ‐ Request in the Pattern window to open the Add 
Extended Link Service Pattern dialog.

Figure 2.22: Extended Link Service - Request Pattern Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type, click the dropdown list.
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Extended Link Service ‐ Request, Reply

Double‐click Extended Link Service ‐ Request, Reply in the Pattern window to open the 
Add Extended Link Service Pattern dialog.

Figure 2.23: Add Extended Link Service - Request, Reply Pattern Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type, click the dropdown list.
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Extended Link Service ‐ Reply

Double‐click Extended Link Service ‐ Reply in the Pattern window to open the Add 
Extended Link Service Pattern dialog.

Figure 2.24: Extended Link Service - Reply Pattern Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type, click the dropdown list.
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GS Patterns

Generic Link Service ‐ Request

Double‐click Generic Link Service ‐ Request in the Pattern window to open the Add 
Generic Link Service Pattern dialog.

Figure 2.25: Generic Link Service Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command.
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Generic Link Service ‐ Request, Reply

Double‐click Generic Link Service ‐ Request, Reply in the Pattern window to open the 
Add Generic Link Service Pattern dialog.

Figure 2.26: Generic Link Service-Request, Reply Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command.
    SierraFC M164 Protocol Analyzer User Manual 59



LeCroy Corporation Easy Mode (Pre‐Defined Setups)
Generic Link Service ‐ Reply

Double‐click Generic Link Service ‐ Reply in the Pattern window to open the Add 
Generic Link Service Pattern dialog.

Figure 2.27: Generic Link Service Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command.
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SW Patterns

Switch Internal Link Service ‐ Request

Double‐click Switch Internal Link Service ‐ Request in the Pattern window to open the 
Add Switch Internal Link Service Pattern dialog.

Figure 2.28: Switch Internal Link Service Pattern Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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Switch Internal Link Service ‐ Request, Reply

Double‐click Switch Internal Link Service ‐ Request, Reply in the Pattern window to open 
the Add Switch Internal Link Service Pattern dialog.

Figure 2.29: Switch Internal Link Service-Request, Reply Pattern Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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Switch Internal Link Service ‐ Reply

Double‐click Switch Internal Link Service ‐ Reply in the Pattern window to open the Add 
Switch Internal Link Service Pattern dialog.

Figure 2.30: Switch Internal Link Service Pattern Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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FICON

Any Data Information Block Type

Double‐click FICON ‐ (Any Data Information Block Type) in the Patterns Library panel to 
open the FICON ‐ Any Data Information Block Type dialog.

Figure 2.31: FICON - (Any Data Information Block Type) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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Add FICON Data

Double‐click FICON(Data) in the Patterns Library panel to open the FICON Data dialog.

Figure 2.32: FICON (Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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Add FICON Command

Double‐click FICON(Command) in the Patterns Library panel to open the FICON 
Command dialog.

Figure 2.33: FICON (Command) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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FICON[Command]‐Any CCW Command Type

The FICON[Command] has an additional Any CCW Command Type dropdown menu 
under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.34: FICON[Command] - Any CCW Command Type Dialog

To select Any CCW Command Type click the dropdown list which has the following 
options:

 Any CCW Command Type
 Sense 
 Read‐Backward 
 Write 
 Read
 Control
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Add FICON Status

Double‐click FICON(Status) in the Patterns Library panel to open the FICON Status dialog.

Figure 2.35: FICON (Status) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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FICON[Status]‐ Any Flag‐Field Code

The FICON[Status] has an additional Any Flag‐Field Code dropdown menu under the 
Value pane on the right of the dialog as shown in the following figure.

Figure 2.36: FICON[Status] - Any Flag-Field Code Dialog

To select Any Flag‐Field Code click the dropdown list which has the following options:

 No Function
 Queueing Information Valid
 Resetting Event
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FICON[Status]‐Any Status Byte

The FICON[Status] has an additional Any Status Byte dropdown menu under the Value 
pane on the right of the dialog as shown in the following figure.

Figure 2.37: FICON[Status] - Any Status Byte Dialog

To select Any Status Byte click the dropdown list which has the following options:

 Attention
 Status Modifier
 Control Unit End
 Busy
 Channel End
 Device End
 Unit Check
 Unit Exception
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Add FICON Control

Double‐click FICON(Control) in the Patterns Library panel to open the FICON Control 
dialog.

Figure 2.38: FICON (Control) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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FICON[Control]‐Any Control Function

The FICON[Control] has an additional Any Control Function dropdown menu under the 
Value pane on the right of the dialog as shown in the following figure.

Figure 2.39: FICON[Control] - Any Control Function Dialog

To select Any Control Function click the dropdown list which has the following options:

 Control End
 Command Response
 Stack Status
 cancel
 System Request
 Selective Reset
 Request Status
 Device Level Exception
 Status Accepted
 Device Level Acknowledgement
 Purge Path
 Purge Path Response
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Add FICON Command‐Data

Double‐click FICON(Command‐Data) in the Patterns Library panel to open the FICON 
Command Data dialog.

Figure 2.40: FICON (Command Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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FICON[Command]‐Any CCW Command Type

The FICON[Command‐Data] has an additional Any CCW Command Type dropdown menu 
under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.41: FICON[Command-Data] - Any CCW Command Type Dialog

To select Any CCW Command Type click the dropdown list which has the following 
options:

 Sense 
 Read‐Backward 
 Write 
 Read
 Control
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Add FICON Link‐Control

Double‐click FICON(Link‐Control) in the Patterns Library panel to open the FICON Link 
Control dialog.

Figure 2.42: FICON (Link-Control) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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FICON[Link Control]‐Any Link Control Function

The FICON[Link Control] has an additional Any Link Control Function dropdown menu 
under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.43: FICON[Link Control] - Any Link Control Function Dialog

To select Any Link Control Function click the dropdown list which has the following 
options:

 Establish Logical Path
 Remove Logical Path
 Test Initialization
 Logical Path Established
 Logical Path Removed
 Test Initialization Result
 Link‐Level Reject
 Link‐Level Busy
 Link‐Level Acknowledgement
76   SierraFC M164 Protocol Analyzer User Manual



Easy Mode (Pre‐Defined Setups)     LeCroy Corporation
FCAE

FCAE‐ASM 

Double‐click FCAE‐ASM in the Patterns Library panel to open the FCAE‐ASM dialog to add 
any Type of FCAE‐ASM.

Figure 2.44: FCAE-ASM Dialog

The format can be Binary or Hexadecimal.
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FCAE‐1553 Any 

Double‐click FCAE‐1553(Any) in the Patterns Library panel to open the FCAE‐1553 dialog 
to add any Type of FCAE‐1553.

Figure 2.45: FCAE-1553 (Any) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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Add FCAE‐1553 Data

Double‐click FCAE‐1553(Data) in the Patterns Library panel to open the FCAE‐1553 Data 
dialog.

Figure 2.46: FCAE-1553(Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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Add FCAE‐1553 Command

Double‐click FCAE‐1553(Command) in the Patterns Library panel to open the FCAE‐1553 
Command dialog.

Figure 2.47: FCAE-1553 (Command) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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FCAE‐1553[Command]‐Any Data Byte Count /Mode Code

The FCAE‐1553[Command] has an additional Any Data Byte Count /Mode Code 
dropdown menu under the Value pane on the right of the dialog as shown in Figure 2.46. 
The dropdown menu items could be truncated, hover the mouse over the option to see 
the full menu option (see the following figure).

Figure 2.48: Hover the Mouse to see the Full Menu Option

Figure 2.49: FCAE-1553[Command]- Any Data Byte Count/Mode Code Dialog

To select Any Data Byte Count/Mode Code click the dropdown list which has the 
following options:

 Dynamic Network Control
 Synchronize (without data word)
 Transmit Status Sequence
 Initiate Self‐Test
 Transmitter Shutdown
 Override Transmitter shutdown
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 Inhibit Terminal Flag (T/F)
 Override Inhibit Terminal Flag
 Reset Network Terminal 
 Transmit Vector Word
 Synchronize (with data word)
 Transmit Last Command Sequence
 Transmit Built In test
 Selected Transmitter Shutdown
 Override Selected Transmitter Shutdown
 Transmit RT Address
 Transmit NT_C‐D/S_BURST_TOV
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Add FCAE‐1553 Status

Double‐click FCAE‐1553(Status) in the Patterns Library panel to open the FCAE‐1553 
Status dialog.

Figure 2.50: FCAE-1553 (Status) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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FCVI

The following patterns are available for FCVI:

FCVI(Any)

FCVI(SEND_RQST)

FCVI(WRITE_RQST)

FCVI(READ_RQST)

FCVI(SEND_RESP)

FCVI(WRITE_RESP)

FCVI(READ_RESP)

FCVI(CONNECT_RQST)

FCVI(DISCONNECT_RQST)

FCVI(CONNECT_RESP1)

FCVI(CONNECT_RESP2)

FCVI(CONNECT_RESP3)

FCVI(DISCONNECT_RESP)

Double‐click on any of the FCVI patterns listed above in the Patterns Library panel to open 
the FCVI dialog. Select a FCVI service from the dropdown list which has the options listed 
above. The format can be Binary or Hexadecimal.

Figure 2.51: FCVI Service Dialog
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FCAV

Two FCAV Patterns patterns are available:

FCAV(Simple)

FCAV(Extended)

Double‐click on any of the FCAV patterns listed above in the Patterns Library panel to 
open the FCAV dialog. Select an FCAV service from the dropdown list which has the two 
options listed above. Format can be Binary or Hexadecimal.

Figure 2.52: FCAV Service Dialog

To select the value for Add FCAV, Simple or Extended Container Header, click on the drop‐
down menu and select from the options listed below

 Any Video Fr. Rate
 Null
 15
 20
 24
 24*1000/1001
 24 (Segmented frames)
 24*1000/1001 (Segmented frames)
 25 (PAL)
 30
 30*1000/1001 (29.97 NTSC)
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 50
 60
 60*1000/1001 (59.94 NTSC)

Figure 2.53: FCAV Container Header Values Dialog

To select the value for Add FCAV, Simple or Extended Object Information Block, click on 
the drop‐down menu and select from the options listed below

 Any Object Type
 Video ‐ uncompressed
 Video ‐ compressed
 Video ‐ reserved
 Video Program
 Video Program ‐ reserved
 Graphics
 Graphics ‐ reserved
 Audio ‐ uncompressed
 Audio ‐ compresses
 Audio ‐ reserved
 Ancillary Data
 Full Stream ‐ structures
 Full Stream ‐ reserved
 Negotiated
 Vendor Specific
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Figure 2.54: FCAV Object Information Values Dialog
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VSAN Basic

VSAN‐Basic Link Service

Double‐click VSAN‐Basic Link Service in the Patterns Library panel to open the VSAN‐
Basic Link Service dialog to add any Type of VSAN‐Basic Link Service.

Figure 2.55: VSAN-Basic Link Service Dialog

The format can be Binary or Hexadecimal.

To select a VSAN‐Basic Link Service click the dropdown list which has the following 
options:

 Any
 NOP
 ABTS 
 BA_ACC
 BA_RJT
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VSAN‐Link Control Frame

Double‐click VSAN‐Link Control Frame in the Patterns Library panel to open the VSAN‐
Link Control Frame dialog to add any Type of VSAN‐Link Control Frame.

Figure 2.56: VSAN-Link Control Frame Dialog

The format can be Binary or Hexadecimal.

To select a Frame type click the dropdown list which has the following options:

 Any Link Control Frame Type
 ACK_1
 ACK_0
 P_RJT
 F_RJT
 P_BSY
 F_BSY_DATA_FRM
 F_BSY_LINK_CTRL
 LCR
 NTY
 END
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VSAN Basic

Add VSAN‐FCP SCSI Command

Double‐click VSAN FCP SCSI Command in the Patterns Library panel to open the VSAN 
FCP SCSI Command dialog.

Figure 2.57: VSAN FCP SCSI Command Dialog

The format can be Binary or Hexadecimal.

To select a VSAN FCP SCSI Command Type select from the following options:

 Any SCSI Command
 MMC_6
 SBC_3
 SMC_3
 SPC_4
 SSC_2
 OSD_2
 ADC_3
90   SierraFC M164 Protocol Analyzer User Manual



Easy Mode (Pre‐Defined Setups)     LeCroy Corporation
Add VSAN‐FCP Frame Information Unit

Double‐click VSAN‐FCP Frame Information Unit in the Patterns Library panel to open the 
VSAN‐FCP Frame Information Unit dialog.

Figure 2.58: VSAN-Frame Information Unit Dialog

The format can be Binary or Hexadecimal.

To select a VSAN‐Frame Information Unit Type click the dropdown list which has the 
following options:

 Any 
 FCP_DATA
 FCP_CONFIRM
 FCP_XFER_RDY
 FCP_CMD
 FCP_RSP
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Add VSAN‐SCSI Command Status

Double‐click VSAN‐SCSI Command Status in the Patterns Library panel to open the VSAN‐
SCSI Command Status dialog.

Figure 2.59: VSAN-SCSI Command Status Dialog

You can capture on Status Only or Sense Key/Response Code. Click on Status Only to 
display all the states that are available. Click on the Sense Key/Response Code to display 
all the Format and Sense Keys.

RSP_CODE: It is selected by default. You can click on the dropdown list to select more 
options.
92   SierraFC M164 Protocol Analyzer User Manual



Easy Mode (Pre‐Defined Setups)     LeCroy Corporation
Add VSAN FCP Task Management

Double‐click VSAN FCP Task Management in the Patterns Library panel to open the VSAN 
FCP Task Management dialog.

Figure 2.60: VSAN FCP Task Management Dialog

The format can be Binary or Hexadecimal.

To select a Function click the dropdown list which has the following options:

 QUERY TASK SET
 ABORT TASK SET
 CLEAR TASK SET
 QUERY UNIT ATTENTION
 LOGICAL UNIT RESET
 TARGET RESET
 CLEAR ACA
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VSAN‐FCP Task Management ‐Task Attribute

The VSAN‐FCP Task Management has an additional Any Task Attribute dropdown menu 
under the Value pane on the right of the dialog as shown in the following figure. 

Figure 2.61: VSAN-FCP Task Management Any Task Attribute Dialog

To select a Any Task Attribute click the dropdown list which has the following options:

 SIMPLE
 HEAD OF QUEUE
 ORDERED
 ACA
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VSAN ARB

Add VSAN‐ARB Loop Initialization

Double‐click VSAN‐ARB Loop Initialization in the Patterns Library panel to open the 
VSAN‐ARB Loop Initialization dialog.

Figure 2.62: VSAN-ARB Loop initialization Dialog

The format can be Binary or Hexadecimal.

To select a Loop Init Id click the dropdown list which has the following options:

 Any
 LISM
 LIFA
 LIPA
 LIHA
 LISA
 LIRP
 LILP
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VSAN ELS Patterns

VSAN‐Extended Link Service ‐ Request

Double‐click VSAN‐Extended Link Service ‐ Request in the Pattern window to open the 
Add VSAN‐Extended Link Service Pattern dialog.

Figure 2.63: VSAN-Extended Link Service - Request Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type and Command, click the dropdown list. 
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VSAN‐Extended Link Service ‐ Request, Reply

Double‐click VSAN‐Extended Link Service ‐ Request, Reply in the Pattern window to open 
the Add VSAN‐Extended Link Service ‐ Request, Reply Pattern dialog.

Figure 2.64: Add VSAN- Extended Link Service - Request, Reply Pattern Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type and Command, click the dropdown list. 
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VSAN‐Extended Link Service ‐ Reply

Double‐click VSAN‐Extended Link Service ‐ Reply in the Pattern window to open the Add 
VSAN‐Extended Link Service Pattern dialog.

Figure 2.65: VSAN-Extended Link Service - Reply Pattern Dialog

The format can be Binary or Hexadecimal.

To select an ELS_Type and Command, click the dropdown list. 
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VSAN-GS Patterns

VSAN‐Generic Link Service ‐ Request

Double‐click VSAN‐Generic Link Service ‐ Request in the Pattern window to open the Add 
VSAN‐Generic Link Service ‐ Request Pattern dialog.

Figure 2.66: VSAN-Generic Link Service - Request Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command. The following GS_Type options are available:

 FC‐SW‐5
 Event Service
 Key Distribution Service
 Alias Service
 Management Service
 Time Service 
 Directory Service
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VSAN‐Generic Link Service ‐ Request, Reply

Double‐click VSAN‐Generic Link Service ‐ Request, Reply in the Pattern window to open 
the Add VSAN‐Generic Link Service ‐ Request, Reply Pattern dialog.

Figure 2.67: VSAN-Generic Link Service-Request, Reply Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command. The following GS_Type options are available:

 FC‐SW‐5
 Event Service
 Key Distribution Service
 Alias Service
 Management Service
 Time Service 
 Directory Service
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VSAN‐Generic Link Service ‐ Reply

Double‐click VSAN‐Generic Link Service ‐ Reply in the Pattern window to open the Add 
VSAN‐Generic Link Service ‐ Reply Pattern dialog.

Figure 2.68: VSAN-Generic Link Service - Reply Pattern Dialog

The format can be Binary or Hexadecimal.

Click the dropdown lists to select a GS_Type, GS_Subtype, Command Type, and 
Command. The following GS_Type options are available:

 FC‐SW‐5
 Event Service
 Key Distribution Service
 Alias Service
 Management Service
 Time Service 
 Directory Service
    SierraFC M164 Protocol Analyzer User Manual 101



LeCroy Corporation Easy Mode (Pre‐Defined Setups)
VSAN-SW Patterns

VSAN‐Switch Internal Link Service ‐ Request

Double‐click VSAN‐Switch Internal Link Service ‐ Request in the Pattern window to open 
the Add VSAN‐Switch Internal Link ‐ Request dialog.

Figure 2.69: VSAN-Switch Internal Link - Request Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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VSAN‐Switch Internal Link Service ‐ Request, Reply

Double‐click Switch Internal Link Service ‐ Request, Reply in the Pattern window to open 
the Add Switch Internal Link Service ‐ Request, Reply dialog.

Figure 2.70: VSAN-Switch Internal Link Service - Request, Reply Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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VSAN‐Switch Internal Link Service ‐ Reply

Double‐click VSAN‐Switch Internal Link Service ‐ Reply in the Pattern window to open 
the Add VSAN‐Switch Internal Link Service Pattern dialog.

Figure 2.71: VSAN-Switch Internal Link Reply Dialog

The format can be Binary or Hexadecimal.

To select a SW_Type and a Command click the dropdown lists.
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VSAN-FICON

VSAN‐FICON (Any Data Information Block Type)

Double‐click VSAN‐FICON(Any Data Information Block Type) in the Patterns Library panel 
to open the VSAN‐FICON(Any Data Information Block Type) dialog.

Figure 2.72: VSAN-FICON (Any Data Information Block Type) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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Add VSAN‐FICON Data

Double‐click VSAN‐FICON(Data) in the Patterns Library panel to open the VSAN‐FICON 
Data dialog.

Figure 2.73: VSAN-FICON (Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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Add VSAN‐FICON Command

Double‐click VSAN‐FICON(Command) in the Patterns Library panel to open the VSAN‐
FICON Command dialog.

Figure 2.74: VSAN-FICON (Command) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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VSAN‐FICON Command‐Any CCW Command Type

The VSAN‐FICON[Command] has an additional Any CCW Command Type dropdown 
menu under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.75: VSAN-FICON[Command] - Any CCW Command Type Dialog

To select Any CCW Command Type click the dropdown list which has the following 
options:

 Any CCW Command Type
 Sense 
 Read‐Backward 
 Write 
 Read
 Control
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Add VSAN‐FICON Status

Double‐click VSAN‐FICON(Status) in the Patterns Library panel to open the VSAN‐FICON 
Status dialog.

Figure 2.76: FICON (Status) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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VSAN‐FICON[Status]‐ Any Flag‐Field Code

The VSAN‐FICON[Status] has an additional Any Flag‐Field Code dropdown menu under 
the Value pane on the right of the dialog as shown in the following figure.

Figure 2.77: VSAN-FICON[Status] - Any Flag-Field Code Dialog

To select Any Flag‐Field Code click the dropdown list which has the following options:

 No Function
 Queueing Information Valid
 Resetting Event
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VSAN‐FICON[Status]‐Any Status Byte

The VSAN‐FICON[Status] has an additional Any Status Byte dropdown menu under the 
Value pane on the right of the dialog as shown in the following figure.

Figure 2.78: VSAN-FICON[Status] - Any Status Byte Dialog

To select Any Status Byte click the dropdown list which has the following options:

 Attention
 Status Modifier
 Control Unit End
 Busy
 Channel End
 Device End
 Unit Check
 Unit Exception
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Add VSAN‐FICON Control

Double‐click VSAN‐FICON(Control) in the Patterns Library panel to open the VSAN‐FICON 
Control dialog.

Figure 2.79: VSAN-FICON (Control) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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VSAN‐ FICON[Control]‐Any Control Function

The VSAN‐FICON[Control] has an additional Any Control Function dropdown menu under 
the Value pane on the right of the dialog as shown in the following figure.

Figure 2.80: VSAN-FICON[Control] - Any Control Function Dialog

To select Any Control Function click the dropdown list which has the following options:

 Control End
 Command Response
 Stack Status
 Cancel
 System Request
 Selective Reset
 Request Status
 Device Level Exception
 Status Accepted
 Device Level Acknowledgement
 Purge Path
 Purge Path Response
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Add VSAN‐FICON Command‐Data

Double‐click VSAN‐FICON(Command‐Data) in the Patterns Library panel to open the 
VSAN‐FICON Command Data dialog.

Figure 2.81: VSAN-FICON (Command Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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VSAN‐FICON[Command]‐Any CCW Command Type

The VSAN‐FICON[Command‐Data] has an additional Any CCW Command Type dropdown 
menu under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.82: VSAN-FICON[Command-Data] - Any CCW Command Type Dialog

To select Any CCW Command Type click the dropdown list which has the following 
options:

 Sense 
 Read‐Backward 
 Write 
 Read
 Control
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Add VSAN‐FICON Link‐Control

Double‐click VSAN‐FICON(Link‐Control) in the Patterns Library panel to open the VSAN‐
FICON Link Control dialog.

Figure 2.83: VSAN-FICON (Link-Control) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
 Control
 Command and Data
 Link Control
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VSAN‐FICON[Link Control]‐Any Link Control Function

The VSAN‐FICON[Link Control] has an additional Any Link Control Function dropdown 
menu under the Value pane on the right of the dialog as shown in the following figure.

Figure 2.84: VSAN-FICON[Link Control] - Any Link Control Function Dialog

To select a Any Link Control Function click the dropdown list which has the following 
options:

 Establish Logical Path
 Remove Logical Path
 Test Initialization
 Logical Path Established
 Logical Path Removed
 Test Initialization Result
 Link‐Level Reject
 Link‐Level Busy
 Link‐Level Acknowledgement
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VSAN FCAE

VSAN‐FCAE‐ASM 

Double‐click VSAN‐FCAE‐ASM in the Patterns Library panel to open the VSAN‐FCAE‐ASM 
dialog to add any Type of VSAN‐FCAE‐ASM.

Figure 2.85: VSAN-FCAE-ASM Dialog

The format can be Binary or Hexadecimal.
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VSAN-FCAE-1553

VSAN‐FCAE‐1553 Any 

Double‐click VSAN‐FCAE‐1553(Any) in the Patterns Library panel to open the VSAN‐FCAE‐
1553 dialog to add any Type of VSAN‐FCAE‐1553.

Figure 2.86: VSAN-FCAE-1553 (Any) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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Add VSAN‐FCAE‐1553 Data

Double‐click VSAN‐FCAE‐1553(Data) in the Patterns Library panel to open the VSAN‐
FCAE‐1553 Data dialog.

Figure 2.87: VSAN-FCAE-1553(Data) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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Add FCAE‐1553 Command

Double‐click VSAN‐FCAE‐1553(Command) in the Patterns Library panel to open the 
VSAN‐FCAE‐1553 Command dialog.

Figure 2.88: VSAN-FCAE-1553 (Command) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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VSAN‐FCAE‐1553[Command]‐Any Data Byte Count /Mode Code

The VSAN‐FCAE‐1553[Command] has an additional Any Data Byte Count /Mode Code 
dropdown menu under the Value pane on the right of the dialog as shown in Figure 2.81. 
The dropdown menu items could be truncated, hover the mouse over the option to see 
the full menu option (see the following figure).

Figure 2.89: Hover the Mouse to see the Full Menu Option

Figure 2.90: VSAN-FCAE-1553[Command]- Any Data Byte Count/Mode Code Dialog
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To select Any Data Byte Count/Mode Code click the dropdown list which has the 
following options:

 Dynamic Network Control
 Synchronize (without data word)
 Transmit Status Sequence
 Initiate Self‐Test
 Transmitter Shutdown
 Override Transmitter shutdown
 Inhibit Terminal Flag (T/F)
 Override Inhibit Terminal Flag
 Reset Network Terminal 
 Transmit Vector Word
 Synchronize (with data word)
 Transmit Last Command Sequence
 Transmit Built In test
 Selected Transmitter Shutdown
 Override Selected Transmitter Shutdown
 Transmit RT Address
 Transmit NT_C‐D/S_BURST_TOV
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Add VSAN‐FCAE‐1553 Status

Double‐click VSAN‐FCAE‐1553(Status) in the Patterns Library panel to open the VSAN‐
FCAE‐1553 Status dialog.

Figure 2.91: VSAN-FCAE-1553 (Status) Dialog

The format can be Binary or Hexadecimal.

To select a Type click the dropdown list which has the following options:

 Any
 Data
 Command 
 Status
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VSAN-FCVI

The following patterns are available for VSAN‐FCVI:

VSAN‐FCVI(Any)

VSAN‐FCVI(SEND_RQST)

VSAN‐FCVI(WRITE_RQST)

VSAN‐FCVI(READ_RQST)

VSAN‐FCVI(SEND_RESP)

VSAN‐FCVI(WRITE_RESP)

VSAN‐FCVI(READ_RESP)

VSAN‐FCVI(CONNECT_RQST)

VSAN‐FCVI(DISCONNECT_RQST)

VSAN‐FCVI(CONNECT_RESP1)

VSAN‐FCVI(CONNECT_RESP2)

VSAN‐FCVI(CONNECT_RESP3)

VSAN‐FCVI(DISCONNECT_RESP)

Double‐click on any of the VSAN‐FCVI patterns listed above in the Patterns Library panel 
to open the VSAN‐FCVI dialog. Select a VSAN‐FCVI service from the dropdown list which 
has the options listed above. The format can be Binary or Hexadecimal.

Figure 2.92: VSAN-FCVI Service Dialog
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VSAN-FCAV

Two VSAN‐FCAV Patterns patterns are available:

VSAN‐FCAV(Simple)

VSAN‐FCAV(Extended)

Double‐click on any of the VSAN‐FCAV patterns listed above in the Patterns Library panel 
to open the VSAN‐FCAV dialog. Select a VSAN‐FCAV service from the dropdown list which 
has the two options listed above. Format can be Binary or Hexadecimal.

Figure 2.93: VSAN-FCAV Service Dialog

To select the value for AddVSAN‐ FCAV, Simple or Extended Container Header, click on the 
drop‐down menu and select from the options listed below

 Any Video Fr. Rate
 Null
 15
 20
 24
 24*1000/1001
 24 (Segmented frames)
 24*1000/1001 (Segmented frames)
 25 (PAL)
 30
 30*1000/1001 (29.97 NTSC)
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 50
 60
 60*1000/1001 (59.94 NTSC)

Figure 2.94: VSAN-FCAV Container Header Values Dialog

To select the value for Add VSAN‐FCAV, Simple or Extended Object Information Block, 
click on the drop‐down menu and select from the options listed below

 Any Object Type
 Video ‐ uncompressed
 Video ‐ compressed
 Video ‐ reserved
 Video Program
 Video Program ‐ reserved
 Graphics
 Graphics ‐ reserved
 Audio ‐ uncompressed
 Audio ‐ compresses
 Audio ‐ reserved
 Ancillary Data
 Full Stream ‐ structures
 Full Stream ‐ reserved
 Negotiated
 Vendor Specific
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Figure 2.95: VSAN-FCAV Object Information Values Dialog
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Custom Frame

Double‐click Custom Frame in the Pattern window to open the Add 
Custom Frame Pattern dialog.

Figure 2.96: Custom Frame Pattern Dialog

The format can be Binary or Hexadecimal.

You can select a Header by checking EXT_H, DEV_H, NWK_H, and/or ASC_H. You can also 
select one or more headers.

If you check EXT_H and/or DEV_H, click the dropdown list to select more options.
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Custom Frame‐Any Type

The Custom Frame has an additional Any Type dropdown menu under the Value pane on 
the right of the dialog as shown in the following figure.

Figure 2.97: Add Custom Frame - Any Type Dialog

To select Any Type click the dropdown list which has the following options:

 Basic Link Service
 ELS
 Obsolete
 IPv4, IPv6 and ARP over FC
 SCSI‐FCP
 Obsolete
 Additional FCP Features
 Obsolete
 SBCCS
 Obsolete
 SBCC SCS
 SBCC SCR
 FC‐GS
 FC‐SW
 Obsolete
 Intr‐Fab Rtr Inter. Link Srvs
 HIPPI‐FP
 FC‐AE 1553
 FC‐ASM
 FC‐VI
 FC‐AV Container
 ARINC 818
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 Generic FC Feat
 RNID Gen. Top. Dis. Page

Protocol Errors

Double‐click Protocol Errors to open the Add Protocol Error Pattern selection dialog.

Figure 2.98: Protocol Error Pattern Dialog

Check protocol error(s) and then click OK.

Trigger Setup

The Trigger tab in the analysis project dialog allows you to specify when the analyzer 
completes a data capture. Three trigger modes are available: The default Snapshot, 
Manual Trigger, and Pattern/Event Trigger.

When data capture starts with Don’t care (Snapshot) selected, the analyzer triggers on 
the first data pattern on the bus. 

Starting a data capture with Pattern selected triggers when specific pattern(s) are 
detected in the captured data stream. The following three ways can trigger the analyzer 
with Pattern selected:

 Trigger on any pattern (Any Trigger Mode)
 External Trigger
 Trigger on a sequence of patterns (Sequential Trigger Mode)
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Snapshot Mode

To trigger immediately on any pattern, check the Snapshot button.

Figure 2.99: Default Trigger Snapshot Mode Selected
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Manual Trigger Mode

In the Manual Trigger mode, the analyzer captures bus traffic continually from when you 
use the Manual Trigger until you click the Stop Hardware button (on the analyzer 
toolbar), which triggers the analyzer. To perform a manual trigger, check the 
Manual Trigger button.

Figure 2.100: Manual Trigger Mode Selected
    SierraFC M164 Protocol Analyzer User Manual 133



LeCroy Corporation Easy Mode (Pre‐Defined Setups)
Pattern/Event/Infusion Trigger Mode
In Pattern/Event Trigger mode, the Analyzer triggers whenever any of the patterns selected for trig‐
gering occurs (an OR condition). The procedure for selecting trigger parameters is identical to that for 
selecting capture parameters. All items selected for triggering appear in the Project Overview pane.

To define patterns for triggering, check the Pattern button in the Trigger dialog.

Figure 2.101: Select Patterns for Trigger

The Patterns Library window displays the following trigger pattern categories (for details 
on each of the trigger pattern refer to “Defining Patterns” on page 45):

 Timers/External
 Timer
 Timeout
 External Trigger
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 Basic
 Connect/Disconnect
 Symbol
 Ordered Set
 Basic Link Service
 Link Control Frame
 Symbol 16G
 Training Sequence

Symbol 16G

Double‐click Symbol 16G in the Pattern Library to set the trigger on Symbol 16G.

Figure 2.102: Add Symbol 16G Dialog

The Sync Header value and the Symbol pattern can be entered.

The Ports can be selected and you can enter the Expected number of occurrences on 
each link in the Count field.
    SierraFC M164 Protocol Analyzer User Manual 135



LeCroy Corporation Easy Mode (Pre‐Defined Setups)
Training Sequence

Double‐click Training Sequence in the Pattern Library to set the trigger on Training 
Sequence.

Figure 2.103: Add Training Sequence Dialog

The Training Sequence pattern can be entered.

The Ports can be selected and you can enter the Expected number of occurrences on 
each link in the Count field.

 FCP
 FCP SCSI Command
 FCP Frame Information Unit
 SCSI Command Status
 FCP Task Management
 Custom Frame

 ARB/ELS
 ARB Loop Initialization
 Extended Link Service ‐ Request
 Extended Link Service ‐ Reply

 GS
 Generic Link Service ‐ Request
 Generic Link Service ‐ Reply

 SW
 Switch Internal Link Service ‐ Request
 Switch Internal Link Service ‐ Reply

 FICON 
 FICON (Any Data Information Block Type)
 FICON (Data)
 FICON (Command)
 FICON (Status)
 FICON (Control)
 FICON (Command‐Data)
 FICON (Link‐Control)
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 FCAE
 FCAE‐ASM
 FCAE‐1553 (Any)
 FCAE‐1553 (Data)
 FCAE‐1553 (Command)
 FCAE‐1553 (Status)

 FCVI
 FCVI (Any)
 FCVI (SEND_RQST)
 FCVI (WRITE_RQST)
 FCVI (READ_RQST)
 FCVI (SEND_RESP)
 FCVI (WRITE_RESP)
 FCVI (READ_RESP)
 FCVI (CONNECT_RQST)
 FCVI (DISCONNECT_RQST)
 FCVI (CONNECT_RESP1)
 FCVI (CONNECT_RESP2)
 FCVI (CONNECT_RESP3)
 FCVI (DISCONNECT_RESP)

 FCAV
 FCAV (Simple)
 FCVI (Extended)

 VSAN
 Basic

 VSAN‐Basic Link Service
 VSAN‐Link Control Frame

 FCP
 VSAN‐FCP SCSI Command
 VSAN‐FCP Frame Information Unit
 VSAN‐SCSI Command Status
 VSAN‐FCP Task Management

 ARB
 VSAN‐ARB Loop Initialization

 ELS
 VSAN‐Extended Link Service‐Request
 VSAN‐Extended Link Service‐Request, Reply
 VSAN‐Extended Link Service‐Reply

 GS
 VSAN‐Generic Link Service‐Request
 VSAN‐Generic Link Service‐Request, Reply
 VSAN‐Generic Link Service‐Reply

 SW
 VSAN‐Switch Internal Link‐Request
 VSAN‐Switch Internal Link‐Request, Reply
 VSAN‐Switch Internal Link‐Reply
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 VSAN‐FICON 
 VSAN‐FICON (Any Data Information Block Type)
 VSAN‐FICON (Data)
 VSAN‐FICON (Command)
 VSAN‐FICON (Status)
 VSAN‐FICON (Control)
 VSAN‐FICON (Command‐Data)
 VSAN‐FICON (Link‐Control)

 VSAN‐FCAE
 VSAN‐FCAE‐ASM
 VSAN‐FCAE‐1553 (Any)
 VSAN‐FCAE‐1553 (Data)
 VSAN‐FCAE‐1553 (Command)
 VSAN‐FCAE‐1553 (Status)

 VSAN‐FCVI
 VSAN‐FCVI (Any)
 VSAN‐FCVI (SEND_RQST)
 VSAN‐FCVI (WRITE_RQST)
 VSAN‐FCVI (READ_RQST)
 VSAN‐FCVI (SEND_RESP)
 VSAN‐FCVI (WRITE_RESP)
 VSAN‐FCVI (READ_RESP)
 VSAN‐FCVI (CONNECT_RQST)
 VSAN‐FCVI (DISCONNECT_RQST)
 VSAN‐FCVI (CONNECT_RESP1)
 VSAN‐FCVI (CONNECT_RESP2)
 VSAN‐FCVI (CONNECT_RESP3)
 VSAN‐FCVI (DISCONNECT_RESP)

 VSAN‐FCAV
 VSAN‐FCAV (Simple)
 VSAN‐FCVI (Extended)

 Custom Frame
 Protocol Errors

Choosing a Parameter
Either highlight the category and click the +>> button, or double‐click the category, to 
open a corresponding definition dialog. Click on the Okay button to move the pattern to 
the Active pane.

To remove an item, highlight it in the Project Tree, then click the ‐<< button.
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Timers/External

Selecting a timer for a trigger in the Any Trigger Mode limits the time that the analyzer 
looks for selected triggering conditions before triggering. The timer activates when the 
Project runs. If none of the selected triggering conditions occurs during the timer’s active 
time, the Analyzer triggers at the end of the time set for the timer.

Timer

You can set a timer independently of any other trigger selection, to cause an 
unconditional trigger after a set time.

Double‐click Timer in the Pattern window to open the Add Timer Pattern dialog.

Figure 2.104: Add Timer Pattern Dialog

Check a Time Unit, enter the Timer Value, and click OK.

Note:The timer and timeout resolution is limited to one DWORD. The minimum value is 12‐13 
DWORD.
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Timeout

Selecting Timeout for the pattern opens the Add Timeout Pattern dialog.

Figure 2.105: Add Timeout Pattern Dialog

Select a pattern for Start Events or End Events, enter a Timeout value, select units, and 
then select Trigger Mode: 

 Trigger If the ‘End Event(s)’ occur(s) before the timer expires
 Trigger if the timer expires before ‘End Event(s)’ occur(s)

Note:You cannot select a Timeout pattern if you select any other pattern as the trigger condition.

External Trigger Pattern

You can trigger on an external trigger. To set up the trigger, click the External Trigger 
pattern. In order to select an External Trigger refer to the “External Trig Setting” on 
page 226.

Figure 2.106: Add External Trigger Pattern Dialog
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Basic Patterns

Connect/Disconnect

See “Basic Patterns” on page 46.

Symbol

Double‐click Symbol in the Pattern window to open the Add Symbol Pattern dialog.

Figure 2.107: Add Symbol Pattern Dialog

Choose a symbol type by checking either the K Symbol or D Symbol option. 

If you choose the K symbol, click the down arrow in the Symbol dropdown list, choose a 
symbol on which to trigger, and click OK. 

The D Symbol choice does not have a down arrow. 

Count is the expected number of occurrences on each link. Default is 1.

Ordered Set

See “Ordered Set” on page 47 for more information.

Basic Link Service

See “Basic Link Service” on page 48 for more information.

Link Control Frame

See “Link Control Frame” on page 49.

Symbol 16G

See “Symbol 16G” on page 135.

Training Sequence

See “Training Sequence” on page 136.
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FCP Patterns

FCP SCSI Command

See “FCP Patterns” on page 50 for more information.

FCP Frame Information Unit

See “FCP Frame Information Unit” on page 51 for more information.

SCSI Command Status

See “SCSI Command Status” on page 52 for more information.

FCP Task Management

See “FCP Task Management” on page 53 for more information.

ARB

ARB Loop Initialization

See “ARB Loop Initialization” on page 54 for more information.

ELS

Extended Link Service ‐ Request

See “Extended Link Service ‐ Request” on page 55 for more information.

Extended Link Service ‐ Request, Reply

See “Extended Link Service ‐ Request, Reply” on page 56 for more information.

Extended Link Service ‐ Reply

See “Extended Link Service ‐ Reply” on page 57 for more information.

GS

Generic Link Service ‐ Request

See “Generic Link Service ‐ Request” on page 58 for more information.

Generic Link Service ‐ Request, Reply

See “Generic Link Service ‐ Request, Reply” on page 59 for more information.

Generic Link Service ‐ Reply

See “Generic Link Service ‐ Reply” on page 60 for more information.

SW

Switch Internal Link Service ‐ Request

See “Switch Internal Link Service ‐ Request” on page 61 for more information.

Switch Internal Link Service ‐ Request, Reply

See “Switch Internal Link Service ‐ Request, Reply” on page 62 for more information.

Switch Internal Link Service ‐ Reply

See “Switch Internal Link Service ‐ Reply” on page 63 for more information.
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FICON

Any Data Information Block Type

See “Any Data Information Block Type” on page 64 for more information.

FICON Data

See “Add FICON Data” on page 65 for more information.

FICON Command

See “Add FICON Command” on page 66 for more information.

FICON Status

See “Add FICON Status” on page 68 for more information.

FICON Control

See “Add FICON Control” on page 71 for more information.

FICON Command Data

See “Add FICON Command‐Data” on page 73 for more information.

FICON Link Control

See “Add FICON Link‐Control” on page 75 for more information.

FCAE

FCAE‐ASM

See “FCAE‐ASM” on page 77 for more information.

FCAE-1553

FCAE‐1553 Any

See “FCAE‐1553 Any” on page 78 for more information.

FCAE‐1553 Data

See “Add FCAE‐1553 Data” on page 79 for more information.

FCAE‐1553 Command

See “Add FCAE‐1553 Command” on page 80 for more information.

FCAE‐1553 Status

See “Add FCAE‐1553 Status” on page 83 for more information.

FCVI

FCVI(Any)

See “FCVI(Any)” on page 84 for more information.

FCVI(SEND_RQST)

See “FCVI(SEND_RQST)” on page 84 for more information.
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FCVI(WRITE_RQST)

See “FCVI(WRITE_RQST)” on page 84 for more information.

FCVI(READ_RQST)

See “FCVI(READ_RQST)” on page 84 for more information.

FCVI(SEND_RESP)

See “FCVI(SEND_RESP)” on page 84 for more information.

FCVI(WRITE_RESP)

See “FCVI(WRITE_RESP)” on page 84 for more information.

FCVI(READ_RESP)

See “FCVI(READ_RESP)” on page 84 for more information.

FCVI(CONNECT_RQST)

See “FCVI(CONNECT_RQST)” on page 84 for more information.

FCVI(DISCONNECT_RQST)

See “FCVI(DISCONNECT_RQST)” on page 84 for more information.

FCVI(CONNECT_RESP1)

See “FCVI(CONNECT_RESP1)” on page 84 for more information.

FCVI(CONNECT_RESP2)

See “FCVI(CONNECT_RESP2)” on page 84 for more information.

FCVI(CONNECT_RESP3)

See “FCVI(CONNECT_RESP3)” on page 84 for more information.

FCVI(DISCONNECT_RESP)

See “FCVI(DISCONNECT_RESP)” on page 84 for more information.

FCAV

FCAV(SIMPLE)

See “FCAV(Simple)” on page 85 for more information.

FCAV(EXTENDED)

See “FCAV(Extended)” on page 85 for more information.

VSAN Basic

VSAN Basic Link Service

See “VSAN‐Basic Link Service” on page 88 for more information.

VSAN Link Control Frame

See “VSAN‐Link Control Frame” on page 89 for more information.
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VSAN-FCP

VSAN‐FCP SCSI Command

See “Add VSAN‐FCP SCSI Command” on page 90 for more information.

VSAN‐FCP Frame Information Unit

See “Add VSAN‐FCP Frame Information Unit” on page 91 for more information.

VSAN‐FCP SCSI Command Status

See “Add VSAN‐SCSI Command Status” on page 92 for more information.

VSAN‐FCP Task management

See “Add VSAN FCP Task Management” on page 93 for more information.

VSAN-ARB

VSAN‐ARB Loop Initialization

See “Add VSAN‐ARB Loop Initialization” on page 95 for more information.

VSAN-ELS

VSAN‐Extended Link Service ‐ Request

See “VSAN‐Extended Link Service ‐ Request” on page 96 for more information.

VSAN‐Extended Link Service ‐ Request, Reply

See “VSAN‐Extended Link Service ‐ Request, Reply” on page 97 for more information.

VSAN‐Extended Link Service ‐ Reply

See “VSAN‐Extended Link Service ‐ Reply” on page 98 for more information.

VSAN-GS

VSAN‐Generic Link Service ‐ Request

See “VSAN‐Generic Link Service ‐ Request” on page 99 for more information.

VSAN‐Generic Link Service ‐ Request, Reply

See “VSAN‐Generic Link Service ‐ Request, Reply” on page 100 for more information.

VSAN‐Generic Link Service ‐ Reply

See “VSAN‐Generic Link Service ‐ Reply” on page 101 for more information.

VSAN-SW

VSAN‐Switch Internal Link ‐ Request

See “VSAN‐Switch Internal Link Service ‐ Request” on page 102 for more information.

VSAN‐Switch Internal ‐ Request, Reply

See “VSAN‐Switch Internal Link Service ‐ Request, Reply” on page 103 for more 
information.
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VSAN‐Switch Internal ‐ Reply

See “VSAN‐Switch Internal Link Service ‐ Reply” on page 104 for more information.

VSAN-FICON

VSAN-FICON Any Data Information Block Type

See “VSAN‐FICON (Any Data Information Block Type)” on page 105 for more information.

VSAN-FICON Data

See “Add VSAN‐FICON Data” on page 106 for more information.

VSAN-FICON Command

See “Add VSAN‐FICON Command” on page 107 for more information.

VSAN-FICON Status

See “Add VSAN‐FICON Status” on page 109 for more information.

VSAN-FICON Control

See “Add VSAN‐FICON Control” on page 112 for more information.

VSAN-FICON Command Data

See “Add VSAN‐FICON Command‐Data” on page 114 for more information.

VSAN-FICON Link Control

See “Add VSAN‐FICON Link‐Control” on page 116 for more information.

VSAN-FCAE-ASM

VSAN-FCAE‐ASM

See “VSAN‐FCAE‐ASM” on page 118 for more information.

VSAN-FCAE-1553

VSAN-FCAE‐1553 Any

See “VSAN‐FCAE‐1553 Any” on page 119 for more information.

VSAN-FCAE‐1553 Data

See “Add VSAN‐FCAE‐1553 Data” on page 120 for more information.

VSAN-FCAE‐1553 Command

See “VSAN‐FCAE‐1553 Command” on page 146 for more information.

VSAN-FCAE‐1553 Status

See “Add VSAN‐FCAE‐1553 Status” on page 124 for more information.

VSAN-FCVI

FCVI(Any)

See “VSAN‐FCVI(Any)” on page 125 for more information.
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FCVI(SEND_RQST)

See “VSAN‐FCVI(SEND_RQST)” on page 125 for more information.

FCVI(WRITE_RQST)

See “VSAN‐FCVI(WRITE_RQST)” on page 125 for more information.

FCVI(READ_RQST)

See “VSAN‐FCVI(READ_RQST)” on page 125 for more information.

FCVI(SEND_RESP)

See “VSAN‐FCVI(SEND_RESP)” on page 125 for more information.

FCVI(WRITE_RESP)

See “VSAN‐FCVI(WRITE_RESP)” on page 125 for more information.

FCVI(READ_RESP)

See “VSAN‐FCVI(READ_RESP)” on page 125 for more information.

FCVI(CONNECT_RQST)

See “VSAN‐FCVI(CONNECT_RQST)” on page 125 for more information.

FCVI(DISCONNECT_RQST)

See “VSAN‐FCVI(DISCONNECT_RQST)” on page 125 for more information.

FCVI(CONNECT_RESP1)

See “VSAN‐FCVI(CONNECT_RESP1)” on page 125 for more information.

FCVI(CONNECT_RESP2)

See “VSAN‐FCVI(CONNECT_RESP2)” on page 125 for more information.

FCVI(CONNECT_RESP3)

See “VSAN‐FCVI(CONNECT_RESP3)” on page 125 for more information.

FCVI(DISCONNECT_RESP)

See “VSAN‐FCVI(DISCONNECT_RESP)” on page 125 for more information.

VSAN-FCAV

VSAN-FCAV(SIMPLE)

See “VSAN‐FCAV(Simple)” on page 126 for more information.

VSAN-FCAV(EXTENDED)

See “VSAN‐FCAV(Extended)” on page 126 for more information.

Custom Frame

See “Custom Frame” on page 129 for more information.
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Protocol Errors

See “Protocol Errors” on page 131 for more information.

Sequential Trigger Mode

In Sequential Trigger mode, triggering occurs whenever the system detects a specific 
sequence of patterns. Defining the triggering patterns sets the sequence order. You must 
define at least two patterns to enable selection of Sequential Trigger mode.

Note:Patterns, such as Primitives and Symbols or Frames, occurring very close together on different 
ports, cause an error in triggering.

To define a triggering sequence, select more than one pattern, then check the Use 
selected patterns in a sequence check box.

Figure 2.108: Select Sequential Trigger Mode

Timer
See “Timer” on page 139 for more information.
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Defining Patterns
The definition of patterns for the sequential trigger mode is identical to the Pattern 
mode, with the following exception: 

In sequential triggering mode, all the pattern dialogs display the option for setting to 
count the expected number of occurrences on each link. This allows you to specify the 
number of times that the pattern must occur before triggering or proceeding in the 
trigger sequence.

Figure 2.109: Number of Occurrences

Note:The Events on each link are counted independently, causing a trigger whenever the number of 
occurrences on any link equals the specified value.

Triggering Order
As triggering patterns are defined and added, they are displayed in the Project Overview 
pane sequentially in the order that they were entered under the Trigger category. When 
the project runs, the analyzer detects the occurrence of each pattern in order and triggers 
on the last one.

You can re‐order the sequence of triggering patterns. To change the sequence order, 
highlight a trigger pattern and use the Up or Down arrow to move it to a new position.

Figure 2.110: Triggering Order
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Pre-Trigger

You can set the amount of data to capture before and after the trigger, as a 
percentage of pre‐trigger, between 0% and 100%. Position the pre‐trigger slider to a 
percentage. This feature allows the evaluation of bus activity leading up to and after the 
triggering Event. Figure 2.111:   illustrates the operation of pre‐trigger in data memory.

Pre‐trigger data is capture of the specified percentage of data prior to the triggering 
Event. It cannot be guaranteed and may be 0. This can occur when the triggering Event 
occurs before storing the required amount of pre‐trigger Event data. In such a case, the 
data display shows fewer than the specified data points prior to the triggering Event.

Figure 2.111: Pre-Trigger Example, 20% Pre-Trigger
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Project Settings

To set project options, click the Analyzer Settings tab. The options on the Analyzer 
Settings are explained below.

Figure 2.112: Setting Project Options
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Buffer Size and Segments

The Analyzer Settings tab has the Recording Buffer pane where you can set Number of 
Segments and the Segment Size. The defaults are one segment of 25MB. The total size 
used is automatically displayed for you. Setting multiple segments will allow to trigger on 
the first occurrence of the trigger condition, fill up the first segment, then automatically 
re‐arm the trigger and repeat the remaining number of segments specified. You can use 
the slider button or click the up or down arrow to change memory usage for recording 
trace data. (Minimum size of memory is 1MB. Maximum size of memory is dependent on 
the hardware.) (See Figure 2.1:   on page 34.) Enter an integer Num. of Segment, from 1 
to 32, then enter an integer Segment Size in kilobytes, up to the memory size in 
megabytes divided by the number of segments. The default 1. 

The New Project dialog opens with default settings to capture Everything on the bus and 
to Trigger On on Snapshot. (The analyzer captures everything immediately without 
triggering on anything in particular.)

Each time a trigger condition occurs, the system records a new segment. You can use a 
Snapshot or Pattern trigger, but not Manual Trigger. As the same trigger automatically 
repeats, the system makes the number of segments that you entered.

Note: If the size of a data packet exceeds the buffer memory allocation, the project runs, but no data 
capture occurs. You must increase buffer memory size to a value greater than the packet size.

Trigger Position

You can set the trigger position in the captured buffer as a percentage of the segment 
size. Trigger point of 0% means the trigger point will be on the first packet in the buffer.

To upload segments automatically for display as the system creates them, do not select 
the checkbox.This defaults to 1, which defines the amount of data to capture before and 
after the triggering Event. You can change this percentage by dragging the slider.

To upload segments manually in the Segment Manager, select the Use upload manager 
(no automatic upload) checkbox. To upload segments automatically for display as the 
system creates them, do not select the checkbox.

Auto Run

To repeat the current capture and trigger setup automatically, check the Auto Run 
checkbox and enter the number of times in the Number of Run text box. The capture and 
trigger repeat automatically for the specified number of times, and the results are saved 
in consecutively numbered Trace.scs files. Each one will use the same settings as 
specified, and will create sequentially named traces. This is identical to pressing the 
record button several times in a row. 
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Trace File Name

Click the ellipses next to the Trace File Name text box and choose a file name and location 
for the results of your current project.

Figure 2.113: Trace File Name

Upload Manager

To view recorded segmented trace files, click the Upload Manager   button, beside the 
Record button, to display the Upload Manager dialog. 

Note:The Upload Manager button is active (green) only after you record a trace.

Figure 2.114: Upload Manager Dialog
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The dialog displays the segments in the format Segment1, Segment2, and so on.

Select segments by clicking the checkbox. You can also Select All or Deselect All 
segments.

You can Upload segments for display, Save segments as sample files, and Delete 
segments.

The Preview radio button allows a preview of an integer number of megabytes around 
the trigger position. You can set the trigger position as a percentage and select the 
segment number. Click the radio button to Show Traffic Summary with the preview. To 
show the preview, click the Preview button.

Analyzer Settings

Channel Enable
Check the relevant ports to enable them.

Note: If a Port ID check box has no check, the analyzer does not capture any patterns for that port. The 
system allocates trace memory for that port to its adjacent port, for example: P1 <‐> P2.

Speed
The default speed is Autospeed. You can also select the port speed from the 
drop‐down list: 1.0 Gbps, 2.0 Gbps, 4.0 Gbps, 8.0 Gbps or 16 Gbps.

Disable Scrambling
If checked, causes the Analyzer to assume that no traffic is scrambled. By default, the 
Analyzer assumes the scrambling state of the devices under test.

Protocol Error Detection
Click the Set Protocol Error Detection button to open the Protocol Error Detection dialog.

Figure 2.115: Protocol Errors Dialog

Uncheck specific Protocol Errors in order to not display them in the sample view and 
Statistical Report.
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Notes 

Add a Project Note

To enter and save information about the current project, click the Notes tab and enter the 
data about the project.

Figure 2.116: Project Notes Tab

Advanced Mode (User-Defined)

Advanced Mode expands Analysis capability by allowing you to program complex 
triggering and data capture projects.

The Advanced Mode is a state machine with up to 23 different states. You can program 
each state individually to:

 Trigger on a different Event or trigger unconditionally.
 Capture Everything, Nothing, or a user‐defined pattern.
 Include up to three ELSE IF statements, allowing a jump to any other state based 

on a user definition.
 Use up to three timers, which you can set to a maximum value of 42949 ms. You 

can set a timer in the state or continue the timer set in the previous state.
 Output an external trigger High or Low.

Note: In Advanced Mode, Events on each link are counted independently. A condition is met if the 
number of Events on a link equals the defined occurrence.
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Working in Advanced Mode

To start working in the Advanced Mode, click the Easy, Switch to Advanced Mode button 
in an open Analyzer window.

You can:

 Display the state definition
 Set Output Trigger level
 Select up to three timers
 Define the If condition and up to three Else If conditions
 Set number of occurrences before trigger
 Set captured data
 Set excluded data
 Go to next state
 Add state
 Choose link for Sequencer setup

Figure 2.117: State Programming Dialog
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Setting Trigger Conditions

To set the If and Else If trigger condition:

1. Click the Add Pattern button   for a Pattern field and choose a trigger 
condition from the drop‐down list. 

Figure 2.118: Choosing a Trigger Condition

2. Define each selected pattern in the same way as in Easy Mode, as described starting 
on page 45. To use a timer, define it first.

Note:You can set a timer for any If or Else If condition.

3. Enter a value for the number of occurrences before trigger in the Cont field, up to a 
maximum of 65535 occurrences.

4. Choose a capture option: Everything, Nothing, or Pattern.

5. If you choose Everything, you can select primitives for exclusion. See “Parameters” 
on page 36.

If you choose Pattern, you can select patterns for inclusion or exclusion. See 
“Defining Patterns” on page 45.

6. Choose pattern(s) and click the +>> button to add them for capture or exclusion. You 
define each pattern the same way as in Easy mode (“Defining Patterns” on page 45).

7. For an output trigger, click the down arrow in the Ext. Out field and choose an 
output trigger level. Note: Do not use the LOW setting in Advanced Mode.
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8. To go to another state, click the down arrow in the Go To field and select a state. If 
no other state has been defined, choose New State to add a state.

Multi-Link Triggering

You can set different triggering for each link. To set different trigger conditions for a link, 
check the Multi Sequencer check box and select the link for setup from the Port drop‐
down list.

Figure 2.119: Multi-Link Triggering Setup

Set Timers

You can set and use up to three timers for triggering. You can set each timer for each 
state or continue from a timer set in the previous state. The timer defined for a particular 
state starts when entering that state. To set timers, click the ellipses in the Timer field in 
each state and define each of the timers in the Timer Pattern dialog.

Figure 2.120: Timer Pattern Dialog
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Useful Key Sequences

The following key sequences are active to assist you in navigating a defined state 
machine:

Ctrl+a Add State

Insert Insert State

Del Delete State

Ctrl+c/Ctrl+Ins Copy

Ctrl+v/Shift+Ins Paste

Up/Down arrow keys Moves selection between states

Page Up/Page Down Page Up and Page Down states

Home Go to first page

End Go to end page

Project Settings

Prior to running the Advanced mode project, click the Settings tab. The options in the 
Settings dialog are the same as for the Easy Mode, described starting on page 151.

Notes

To include some descriptive information about the project, click the Notes tab and enter a 
brief descriptive note (See “Notes” on page 155).
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Chapter 3 

Display Manipulation
Viewer Display

After data is captured (Recorded), the Viewer displays a .fcs sample file in Packet View.

Note that statistics are available only after the whole trace has uploaded. 

Figure 3.1: Spreadsheet View

Figure 3.2: Frame Inspector View
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Figure 3.3: Packet View

Figure 3.4: Text View
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Figure 3.5: Statistical Report View

Figure 3.6: Bus Utilization View 
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You can configure the data viewer display. Toolbars are available for quick access to data 
viewer display features. 

You can display the same data in:

 Spreadsheet view
 Frame Inspector View
 Packet view
 Text view
 Statistical Report view
 Bus Utilization View

Note:You can change the view type when opening a sample by changing the default workspace or by 
saving options in the Software Setting dialog.

Switching Views

To display the capture in any other available view, select from the View menu or from the 
View Type toolbar. 

Figure 3.7: View Type Toolbar

After you select a view, it appears in a separate window. To increase the new window 

display size, select View > Packet View or click the   Show/Hide Packet View 
button to hide the Packet View.

When scrolling through a window display using the scroll bar, the displays in the other 
windows also scroll.

To rearrange the tiling, select the Window menu and choose Cascade, Tile Horizontal, or 
Tile Vertical.

Show/Hide Compare 2 Data Payloads

Show/Hide Spreadsheet View

Show/Hide Frame Inspector View
Show/Hide Packet View

Show/Hide Text View

Show/Hide Statistical Report View

Bus Utilization View
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Spreadsheet View

Spreadsheet View displays all of the Packet View fields in a time sequential spreadsheet 
format.

To display the Spreadsheet View of the current capture, click View > Spreadsheet View 

or click the   button on the View Type toolbar.

Figure 3.8: Spreadsheet View

Save As Text/Excel

Select File > Save As Text/Excel to open the Save As Text dialog. 

For Save As Type, select Text Files or Excel Files.

For Save As Range, select All Packets or enter a cursor range.

Enter a File Name and click Save.

Note:The Save As Excel option is available only for Spreadsheet View and Text View.
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1

Trace Viewer Configuration

In Spreadsheet View, you can also click the Trace Viewer Configuration icon to display 
the Trace Viewer Configuration dialog. Expand the Frame Fields, Sequence Fields, SCSI 
Cmd Fields, ELS Cmd Fields SW Cmd Fields, GS Cmd Fields, FICON Fields, Additional 
Fields, Text View and Spread Sheet View to change the settings.

Spread Sheet View Menu Options

Right‐click on any of the columns in the Spread Sheet view to display a list of menu 
options (see Figure 3.9).

You can also show or hide a port by right‐clicking a Port ID in Spread Sheet View and 
choosing Show or Hide.

Figure 3.9: Menu Options in Spread Sheet View

Bookmark  You can create bookmarks, delete and Goto 
bookmarks.

Add xxx to trigger This option is context sensitive. This option 
allows a quick setting of the trigger for the next 
recording as the item on which the right click was 
done.

Set Time Stamp Origin: There are four options to set time stamp origin.

•Absolute: Sets the time stamp to zero when the recording 
starts. The first time in the trace might have the 
time stamp larger than zero due to filtering, 
hiding or other reasons such as recording started 
in the middle of a frame.

•Trigger: Sets time to when the trace was triggered.

•Current Position:  Sets time to the current position.

•Based on System Time: Sets time based on the system time.

Change Time Stamp Format: Select options to display time stamp format.

Goto Next:  Displays options to go to the next location.

Goto Previous: Displays options to go to the previous location.

Goto Response: Displays options to go to the response location.

This Add xxx to trigger 
allows a quick setting of the 
trigger for the next recording 
as the item on which the 
right click was done
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Add, Edit and Delete Columns

You can customize the columns display by adding, editing or deleting columns. Right‐click 
on the column header and select an option. Selecting Add Columns displays the following 
dialog.

Figure 3.10: Add Column to Spread Sheet View Dialog

Hide:  This option is context sensitive, it displays the 
relevant option to hide it.

Change Background Color: Displays colors to change the background.

Change Foreground Color: Displays colors to change the foreground.

Software Setting: Select options to set the software. For detailed 
information see “Software Settings” on 
page 222.

Goto:  Displays options to go to X or Y Position, Packet 
No., Time Stamp, Bookmark, Begin and End.
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Frame Inspector View

Frame Inspector View has lots of information that is available in Packet View, but not Spread‐
sheet View, so it is most useful in conjunction with the Spreadsheet View.
This view has the following three tabs:

Spec View: 

This view shows the Frame as it would appear in the spec, with the field names and 
values spelled out clearly. Fields that are too short to clearly contain the description can 
be viewed as tooltips by hovering the mouse over them. Some fields might have a a 
lowercase ‘e’ button at the top right corner. Pressing this button displays an ‘expanded’ 
view of the sub‐fields in this field.

Field View: 

This view shows, when applicable, a hierarchical display of the selected Packet, with the 
relevant fields in each level.

Raw Data View: 

This view shows Hex, 10‐bit and Running Disparity views of each dword in the selected 
packet.

To open a Frame Inspector View of the current capture, select View > Frame Inspector 

View or click the   button on the View Type toolbar.

Figure 3.11: Frame Inspector View
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Raw Data View - Frame Inspector View for 64b/66b Decoding

Raw Data View in the Frame Inspector View window shows the exact bit stream in 66b 
format. In this view, a 66 bits block is reconstructed similar to the received data (see the 
screen capture below). The following columns are displayed in the Raw Data View:

 Index: This column demonstrates the index of the 66‐bits symbol in current 
blocks.

 Sync: This column shows the Sync Header bits of a symbol.
 Payload: This column shows the 8 payload bytes in each symbol before scram‐

bling.
 Scrambled: This column shows the 8 payload bytes in each symbol after scram‐

bling.
 FEC Payload: This column shows the 8 payload bytes in each symbol after scram‐

bling.
 T: This column shows the Transcode Bit of each FEC symbol.
 PN‐2112 scrambled: This column shows the scrambled value of each 65‐bits 

block with PN‐2112 scrambler.
 Parity bits:  This value (row) shows FEC parity bits of each FEC block.

Figure 3.12: FC16 Raw Data View with FEC
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Figure 3.13: FC16 Raw Data View without FEC
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Packet View

Packet View displays the captured data interpreted as packets in a hierarchical view.

To display the Packet View, select View > Packet View or click the   button on the 
View Type toolbar.

Figure 3.14: Packet View
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Text View

Text View (Frame List View) displays the captured data interpreted as transaction frames, 
grouped in columns by port.

To display Text View, select View > Text View or click the   button on the View 
Type toolbar.

Figure 3.15: Text View
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Bus Utilization View

The Bus Utilization View displays the bus utilization activity. You can select a graph area to 
view the bus utilization of that area.

To display Text View, select View > Text View or click the   button on the View 

Type toolbar.

Figure 3.16: Bus Utilization View
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Statistical Report View

Statistical Report View displays the statistics of the captured data. For additional 
information see “Statistical Report Toolbar” on page 199.

To display Statistical Report View, select View > Statistical Report View or click the 

 button on the View Type toolbar.

Figure 3.17: Statistical Report View

Customize Display

Show/Hide Port

You can simplify the viewer display by hiding the captures of ports. All active ports are 
highlighted on the Show/Hide Ports toolbar. Click a port button to hide the capture for 
that port.

Figure 3.18: Show/Hide Ports Toolbar
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Show/Hide Field

You can simplify the Viewer display by hiding fields. Click the Filtering Setup   
button on the top toolbar to Show/Hide items. 

 

Figure 3.19: Show/Hide Field

Note:Only the fields previously hidden appear in the restore list.
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Related Frames

Right‐click a frame to open a short‐cut menu, then choose Goto to jump to a related 
frame in the viewer. 

Figure 3.20: Goto Command

Choose Data Format

You can display data values either in hexadecimal (default) decimal, binary, name and 
ASCII. To choose data format, right‐click the mouse over a data field, and choose Format 
and the format.

Figure 3.21: Format
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Data Payload View

To display Data Payload dialog click on the Data Payload button in a data payload packet, 
(see Figure 3.22 on page 177).

Figure 3.22: Data Payload Button Within the Data Payload Packet

The following Data Payload dialog is displayed.

Data Payload button
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Compare Two Data Payloads

To display data payloads, click the  

Show compare 2 Data Payloads icon on the toolbar. This icon is active only when two 
data payloads packets are selected (Figure 3.23 on page 178).

Figure 3.23: Two Data Payload Packets

To compare two data payloads, select two different payload packets, right‐click and select 
one as Set As Reference Data Payload and select the other as Set As Second Data 
Payload. You can compare two data payloads in Packet View or a related frame in Text 
View or Spreadsheet View to display a menu. 

Example of two data 
payload packets
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Figure 3.24: Set Reference and Second Data Payload Packets

Port Status

You can get an overview of the active ports by clicking the Port Status button at the 
bottom right of the application window.

The Port Status displays the Port, Speed, and Function.

In addition to displaying Link, Frame, and Error, a display showing the% buffer full opens 
when a trigger occurs. The Error, Trigger and Buffer indicator columns are displayed only 
when recording.
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Figure 3.25: Port Status Window Displaying Buffer Indicator

Note: If sample capture occurs with more than one unit active, additional Port Status windows display.
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Toolbars

Enabling Tool Bars

To customize the Viewer Display workspace, you can enable and reposition the available 
toolbars. To display or hide toolbars, select View > Toolbars, then check or uncheck 
toolbars.

Figure 3.26: Customizing the Toolbar

Toolbars are:

 Main
 Viewer Setting
 Advance Mode
 Trace Viewer
 Show Layer
 Show View
 Show Channels (Unit 1, Unit2, and so on)
 Cursor Position

Once enabled, the toolbars can dock at the Viewer Display window or float on the 
windows desktop.

Main Toolbar

See “Software Menus and Toolbar” on page 37.

View Type Toolbar

See “Switching Views” on page 164.
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Viewer Toolbar

The Viewer toolbar allows searching, filtering, collapsing/expanding, and data reporting. 

.
The Search button opens the search dialog (see “Search” on 
page 214).

The Filtering Setup button opens the Filter dialog (see “Filtering” on 
page 206) and allows you to specify the criteria for filtering the result.

The Enable Disable Filtering button toggles the result between a 
filtered and unfiltered view (see “Filtering” on page 206).

The Hide All Ordered Sets button hides all the ordered sets. 

The Pack Repeated Ordered Sets button toggles packing repeated 
ordered sets in one port.

The Expand/Collapse all Layers button expands or collapses 
Transport and Application layers to simplify results display.

The down arrow on the Go To button allows location of cursors or 
specific packets: Trigger Position, X Position, Y Position, Packet 
Number, Timestamp, Bookmark, Begin, and End.
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Viewer Setting Toolbar

The Viewer Setting toolbar allows wrapping, zooming, and configuration

 

The SCSI Spec Assignment button displays the SCSI Spec Assignment dialog. 

The Full Screen button on the Viewer Setting Toolbar increases the 
data display area to the full screen.

The Zoom In button on the Viewer Setting Toolbar magnifies the data 
display area on the screen. Clicking this button in Column or Text 
View increases column width only.

The Zoom Out button on the Viewer Setting Toolbar scales the data 
display area to display more data lines on the screen. Clicking this 
button in Column or Text View decreases column width only.
    SierraFC M164 Protocol Analyzer User Manual 183



LeCroy Corporation Switching Views
Cursor Position Status Bar

To display the cursor position status bar, select View>Toolbars > Cursor Position.

Figure 3.27: Cursor Position Toolbar

See “Using Cursors and Bookmarks” on page 210.

Show Layer Toolbar

The Show Layer toolbar shows or hides packet types.

 

.

The Normal Zoom button on the Viewer Setting Toolbar resets the 
zoom to default normal on the screen. Clicking this button in Column 
or Text View resets column width only.

The Wrap Packets button on the Viewer Toolbar wraps the packet 
data in the display to eliminate the need for horizontal scrolling.

The View Setting button on the Viewer Setting Toolbar opens the 
Sample Viewer Configuration dialog (see “Display Configuration” on 
page 217).

The Show/Hide Frame Packets button displays/hides the frame packets 
layer.

The Show/Hide Sequence Packet button displays/hides the sequence 
packet. 

The Show/Hide All of Commands Packet button shows/hides the 
Command layer and all layers below.
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Status Bar

The Status bar is located at the bottom of the main display window. Depending on the 
current activity, the bar can be divided into as many as four segments. 

Recording Progress

When you begin recording, the left‐most segment of the Status Bar displays a Recording 
Progress Indicator. 

As recording progresses, the Progress Indicator changes to reflect the recording progress 
graphically:

In the Progress Indicator, a black vertical line illustrates the location of the Trigger Position 
you selected in Recording Options. 

 Pre‐Trigger progress is displayed in the field to the left of the Trigger Position in 
the before‐Trigger color specified in the Display Options. 

 When the Trigger Position is reached, the progress indicator wiggles as it waits 
for the trigger. 

 After the trigger occurs, the field to the right of the Trigger Position fills in the 
after‐Trigger color specified in the Display Options. 

 When recording is complete, the upper half of the progress indicator fills in 
white, indicating the progress of the data upload to the host computer.

You should be aware of two exceptional conditions: 

 If a Trigger Event occurs during the before‐Trigger recording, the before‐Trigger 
color changes to the after‐Trigger color to indicate that not all the expected data 
was recorded pre‐Trigger. 

 When you click Stop before or after a Trigger Event, the Progress Bar adjusts 
accordingly to begin uploading the most recently recorded data.

The Progress Bar fills with color in proportion to the specified size and actual rate at 
which the hardware is writing and reading the recording memory. However, the Progress 
Indicator is normalized to fill the space within the Status Bar.

Recording Status 

During recording, the current Recording Status is displayed in the next segment. When 
you activate the Record function, this segment flashes one of the following messages 
(depending on the selected Recording Options):

 Trigger?
 Triggered!
 Uploading

The Order/Reorder Packets based on Time button toggles the time order 
of packets.
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After recording stops, 

 The flashing message changes to Uploading data–x% done (x% indicates the 
percentage completion of the data uploading process). 

 The traffic data is copied to disk (overwriting any previous version of this file) 
using the default file name data[sn].fcs where [sn] is the serial number of the 
analyzer chassis; or the name you assign as the default filename. You can also 
create a file name of your choice by specifying one in the Recording Options dia‐
log box.

To abort the upload process: 

 Press Esc on your keyboard

OR

 Again click   in the Toolbar. 

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display window and 
the Recording Status window is cleared. 

 If the recording resulted from a Trigger Event, the first packet following the Trig‐
ger (or the packet that caused the Trigger) is initially positioned second from the 
top of the display.

 If the recording did not result from a Trigger Event, the display begins with the 
first packet in the traffic file.

Recording Activity

During recording, the fourth segment from the left of the Status Bar displays Recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note: If packets are filtered from the recording or data are truncated, the recording activity is reduced.

Search Status

The right most segment displays the current search direction: Fwd (forward) or 
Bwd (backward). Change the search direction from the Search Menu or double‐click the 
Search Status segment. 
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Statistical Report

Whenever a captured sample is in the Trace Viewer, a Statistical Report selection in the 
Report menu and a Statistical Report Button on the viewer toolbar are enabled. You can 
create a Statistical Report for the entire capture or select a portion of it.

To display a Statistical Report, click the   Statistical Report button on the viewer 
toolbar or select Report > Statistical Report to display the Select Statistical Report Range 
dialog. 

Figure 3.28: Statistical Report Range Dialog

The default statistical report has All Samples. You can set a specific Statistical report range 
between defined cursor positions or Events.

Report between Cursors

Click the option button next to the From cursor selection drop down list. Then click the 
From down arrow and choose the 1st cursor, click the To down arrow to choose the 2nd 
cursor, and click OK. The resulting report has only the capture between the cursors.

Figure 3.29: Report between Cursors
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Report between Events

Click the option button next to the From the Event selection dropdown list, click the From 
down arrow to choose the 1st Event, then enter the number of its occurrence. Next click 
the To down arrow to choose the 2nd Event, then enter the number of its occurrence.

Figure 3.30: Report between Events

Click OK. The resulting report are limited to the capture between the defined Events.

Statistical Report Content

A complete statistical report consists of the following reports, accessed by clicking the 
corresponding tab in the dialog. The Bus Conditions and Protocol Errors tabs appear only 
if there are any changes to the bus condition in the trace or if there are any protocol 
errors.

 Ordered Sets
 Frame
 Bus Conditions
 SCSI Commands
 Protocol Errors
 Ports
 Pending IO
 ELS Commands 
 GS Commands 
 AL Commands 
 Exchange Performance

Note:Results are displayed only for items that have been captured in the sample.

The data in the Statistical Report can be sorted in ascending or descending order by 
clicking on the column header.

Report Options

Some report categories offer options to display only specific items.These report 
categories incorporate drop‐down list boxes offering pre‐defined and custom options. For 
details see “Formatting the Statistical Report View” on page 202.
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Ordered Sets

To display the Ordered Sets, click the Ordered Sets tab. The Ordered Sets Report displays 
report data shown in the following screen shot. The report displays the following 
information:

 Type: All, Custom, SOFn3, EOFn, EOFt, SOFi3 
 Port: The ports that are selected
 Count: All, Custom, or a number of occurrences
 %: Percent of total count

Figure 3.31: Ordered Sets Statistical Report View

Frame Report

To display the Frame Report, click the Frame tab. The report gives the statistics of the 
frame. The following information is displayed in this report:

 Port: The ports that are selected
 Source ID: All, Custom and other
 Destination ID: All, Custom and other
 Type: Select from the dropdown list
 Count: All, Custom, or a number of occurrences
 %: Percent of total count

Figure 3.32: Frame Statistical Report
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Bus Conditions Report 

To display the Bus Conditions Report, click the Bus Conditions tab. The Bus Conditions 
Report displays the conditions of the bus. The following information is displayed in this 
report: 

 Port: The ports that are selected
 Type: All, Custom, Disconnect, Connect
 Count: All, Custom, or a number of occurrences
 %: of total count

Note:The Bus Conditions tab appears only if there are any changes to the bus condition in the trace.

Figure 3.33: Bus Conditions Statistical Report
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SCSI Commands Report

To display the SCSI Command Report, click the SCSI Command tab. The SCSI Command 
Report displays data shown in the screen capture below. The following information is 
displayed in this report: 

 Port: The ports that are selected
 Source ID
 Destination ID
 Type: All, Custom, Report LUNs, Inquiry, Read Capacity (10), Read (10), Mode 

Sense (6)
 Payload Size: All, Custom, or a number of Dwords
 Seq No: All, Custom and other
 Status: All, Custom, Good, Check Condition
 Duration: All, Custom and other
 Count: All, Custom, or a number
 %: of total count

Figure 3.34: SCSI Command Report
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Protocol Errors Report

To display the Protocol Errors Report, click the Protocol Errors tab.The Protocol Errors 
Report displays the protocol error data. The following information is displayed in this 
report: 

 Port: The ports that are selected
 Type: All, Custom, Symbol Violation, Disparity Error, Primitive Error
 Count: All, Custom, or other
 %: of total count

Note:The Protocol Errors tab appears only if there are any protocol errors in the trace.

Figure 3.35: Protocol Errors Report
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Ports Report

To display the Ports Report, click the Ports tab.The Ports Report displays data of the ports. 
The following information is displayed in this report: 

 Port: The ports that are selected
 SCSI Count
 ELS Count
 GS Count
 SW Count
 AL Count
 Incomplete Count
 Total XFer
 Utilization
 Utilization %

Figure 3.36: Ports Report
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Pending IO Report

To display the Pending IO Report, click the Pending IO tab.The Pending IO Report displays 
data of the pending IOs. The following information is displayed in this report: 

 Port: The ports that are selected
 Pending IO
 Max. Pending IO
 Avg. Pending IO

Figure 3.37: Pending IO Report
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ELS Commands

To display the ELS Commands Report, click the ELS Commands tab. The ELS Commands 
Report displays the ELS Commands data. The following information is displayed in this 
report:

 Port: The ports that are selected
 Source ID: All, Custom, FABRIC, and other
 Destination ID: All, Custom Fabric and other
 Type: All, Custom, and other
 Response Type: All, Custom, Accept and Incomplete
 Duration: All, Custom and other
 Count: All, Custom, or a number of occurrences
 %: Percent of total count

Figure 3.38: ELS Commands Report
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GS Commands

To display the GS Commands Report, click the GS Commands tab. The following 
information is displayed in this report:

 Port: The ports that are selected
 Source ID: All, Custom, and other
 Destination ID: All, Custom, and other
 Type: All, Custom, Management Service, Directory Service
 SubType: All, Custom, Fabric Device Management Interface, Unzoned Name 

Server, Name Server, Fabric Configuration Server
 Command Code: All, Custom, FETCH, and other
 Response Type: All, Custom, Reject and Accept
 Duration: All, Custom and other
 Count: All, Custom, or a number of occurrences
 %: Percent of total count

Figure 3.39: GS Commands Report
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SW Commands

To display the SW Commands Report, click the SW Commands tab. The following 
information is displayed in this report:

 Port: All, Custom and ports that are selected
 Source ID: All, Custom, FABRIC and other
 Destination ID: All, Custom, FABRIC and other
 Type: All, Custom and other
 SubType: All, Custom, Fabric Device Management Interface, Unzoned Name 

Server, Name Server, Fabric Configuration Server
 Command Code: All, Custom, FETCH, and other
 Response Type: All, Custom, Reject and Accept
 Duration: All, Custom and other
 Count: All, Custom, or a number of occurrences
 %: Percent of total count

Figure 3.40: SW Commands Report
    SierraFC M164 Protocol Analyzer User Manual 197



LeCroy Corporation Statistical Report
198   SierraFC M164 Protocol Analyzer User Manual

AL Commands

To display the AL Commands Report, click the AL Commands tab. The following 
information is displayed in this report:

 Port: All, Custom and ports that are selected
 Source ID:
 Destination ID:
 Type: All, Custom and other
 Duration: All, Custom and other
 Count
 %

Figure 3.41: AL Commands Report

Exchange Performance Report

To display the Exchange Performance Report (see Figure 3.42 on page 199), click the 
Exchange Performance tab. The following information is displayed in this report:

 Port: All, Custom and ports that are selected
 Source ID
 Destination ID
 R/W Type
 Min Response
 Max Response
 Average Response
 Min Efficiency
 Max Efficiency
 Average Efficiency
 Total Command
 Total Byte
 Total Duration: All, Custom and other
 Min RW/Sec
 Max RW/Sec
 Average RW/Sec
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Figure 3.42: Exchange Performance Report

Statistical Report Toolbar

The Statistical Report toolbar provides the following functions accessible by buttons on 
the toolbar:

 Export to Excel
 Save as Text
 Print Report
 Print Preview
 Report Display Settings
 Move to X‐Cursor, Y‐Cursor, or None 
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Export as Microsoft® Excel file

Save as Text file

Print Statistical Report

Print Preview

Figure 3.43: Sample Print Preview of Report

The Export to Excel button opens the Export to Excel dialog. Choose a 
folder in which to save the Excel file, choose an appropriate file 
name, and click Save.

The Save as Text button opens the Export to Text dialog. Choose a 
folder in which to save the Text file, choose an appropriate file name, 
and click Save.

The Print button opens the select printer dialog. Choose an available 
printer and click OK.

The Print Preview button displays a preview of the report to print. 
See Figure 3.43 on page 200.
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Report Display Settings

You can set up the report columns for display to suit a particular analysis need, 
eliminating the need to show/hide columns individually. Use the Setting dialog to 
configure the display for each page. See Figure 3.44 on page 201.

Figure 3.44: Statistical Report Column Setting

Link With Sample View

When you select a type on any page of the Statistical Report, a set of navigation buttons 
allows you to examine each instance of that type in the Trace Viewer. 

The Setting button opens the Setting dialog.

The Jump to Previous button goes to the previous instance of the 
selected type in the Trace Viewer.

The Jump to Next button goes to the next instance of the selected 
type in the Sample Viewer. 

The Jump to Specific button goes to the instance specified as N of M 
items on the Statistical Report toolbar.
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Formatting the Statistical Report View

Initially the Statistical Report View contains all of the information in columns, but you can 
customize the display by:

 Filtering columns by item
 Sorting items by column
 Hiding any column on the display

Filtering Column Content

To filter column content, click the down arrow in the heading for that column and choose 
the items to display. The default is All. By checking a specific item, you exclude everything 
but that item for display.

Choosing Custom allows you to specify more than one item for display. Check the items 
to display and click OK.

Sorting Column Content

To sort column content, click the heading for that column. Repeated clicking of the 
column heading sorts the column in ascending or descending order.

Hiding Columns

To hide a column, right‐click in the column and choose Hide. To unhide a column, right‐
click any column and choose Unhide.

Formatting Columns

To format a column, right‐click in the column and choose Format. The options are:

 Hexadecimal
 Binary
 ASCII
 Decimal

  The Move drop‐down list moves to the X‐Cursor, Y‐Cursor, or None.
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Tools

The Tools menu displays two options:

1. Self Test 

2. Verification Script.

Self Test

You can use the built‐in self‐test utility. The self test is performed to check the clock, 
memory, serdes, crosspoint, LED/buzzer settings are good. Go to Tools on the main menu 
bar and choose Self Test to open the Self Test dialog. See Figure 3.45 on page 203.

Figure 3.45: Tools - Self Test Dialog

Test Result Column

If a test is OK and you specified one run, the Test Result column on the right displays OK: 1 
times (see the screen capture above).

If a test has an error and you specified one run, the Test Result column on the right 
displays Error: 1 times (see the screen capture above).

Saving

You can save any check result by checking the Save error details check box and specifying 
a destination file name.
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Number of Runs Each Test

You can specify to run a test more than once.

Run All Tests Sequentially

Check this box to run tests sequentially.

Verification Scripts

You can use the built‐in verification script utility. Verification Scripts utilize the VSE 
('engine') to parse traces for specific events and reports. For additional details on VSE, 
refer to the Verification Script Engine for SierraFC Protocol Suite Reference Manual.

Go to Tools on the main menu bar and choose Verification Script to open the Verification 
Script dialog. See Figure 3.46.

Figure 3.46: Tools - Verification Script Dialog
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Run Script

You can run scripts with the tests available in the Verification Script Dialog.

Choose the function to test and click the Run Scripts button. After a short time, the result 
appears in the log pane.

Click Expand Log to expand or collapse the log pane.

You can save the output. Click Save Output to open the Saving Output dialog. See 
Figure 3.47 on page 205. 

Figure 3.47: Saving Output Dialog

Settings

The settings for the Editor Application, Display and Save options can be made in the 
Settings dialog. Click Settings to open the Settings DIalog. Select the desired options and 
click OK.
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Figure 3.48: Settings Dialog

Filtering

The Filtering menu and options allow you to modify data in the sample viewer display to 
exclude packets with a set of user‐defined patterns and show the results in all views.

To set up filtering, you must have a viewer display open.

Filter Setup

To display the Filter setup dialog, click the   Filter button on the Viewer toolbar 

or select Filtering > Filtering. 
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Figure 3.49: Filter Setup Dialog

You can select or deselect each of the items shown in the Filter Options window for 
filtering, by checking or unchecking a corresponding check box. Items not in the current 
sample are in shade.

NOTE 1: If you select a group, that also selects all child items. 

NOTE 2: Only packets captured at run time are available for selection for filtering.

Filter Type

You can choose to show or hide the Filter Type items by checking the Show or Hide 
option button.

Filtering Direction

You can select items for filtering in a single direction or both directions by checking the 
corresponding Port. By default, all ports are enabled. Uncheck the port check boxes for 
ports not to include in the filter.

Filter Idle

Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are shown 
or hidden.
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Save Filter Setup

After you have set up a Filter configuration, you can save it as a Filter file by clicking Save. 
You can then use it on a different capture by clicking Load in the Filter dialog.

Filter Logic

After you have set up Filter options, you can set filter logic to And Related Items to apply 
“AND” logic on related selected options or OR to apply “OR” logic on all selected options.

Multilevel Filtering

You can set up a filter in a sequential steps by Multi level filtering. In each level, you can 
select specific items to “AND” to the previous level. The results of all levels show in views.

Filter descend packets by ascend packet

You can apply a filter on a descend packet if you check the Filter descend packet if 
ascend packet is filtered option. If you uncheck this option, the software only filters the 
filtered packet. For example, if this option is checked and any SCSI command is selected, 
all transport and link packets of this command are filtered,. If you unchecked this option, 
only selected SCSI commands are filtered.

Selectable Filter Options

The Filter Options are (see Figure 3.50 on page 209):

 Bus Condition
 Ordered Sets
 Source Address ID
 Destination Address ID
 Pair Addresses
 Originator Exchange ID
 Responder Exchange ID
 SCSI Commands
 Task Management Functions
 SCSI Command Status (see “Filter Check Condition” below)
 Protocol Error
 Extended Link Service Request
 Extended Link Service Reply
 Arbitrated Loop Request
 Basic Link Service
 Switch Fabric Request
 Switch Fabric Reply
 FCP Information Unit
 Generic Service Request
 Generic Service Reply
 Link Control Frame
 Miscellaneous (see “Miscellaneous” below)
 Incomplete Exchange
 FICON Information Unit
 FICON Command
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 FICON Control Function
 FICON Link Control Function

Bus Condition

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Sample Viewer.

Protocol Error

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Sample Viewer.

Filter Check Condition

Checking the SCSI Command Status check box enables Check Condition for filtering.

Filter Miscellaneous

When you choose Miscellaneous, an additional dialog displays, allowing you to specify 
the filtering of State Range and/or External Signal In.

Figure 3.50: Filter State and/or External Signals

Enable Filter

Select Filtering > Enable Filtering or click the   Filter Enable button on the display 
menu bar to toggle between Filtered and Unfiltered display.
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Using Cursors and Bookmarks

Cursors

The data viewer display incorporates three cursors labeled X, Y, and T. All cursors are 
initially overlaid and positioned at location 0, which is the trigger position of the display. 
The Trigger, or T, cursor is the measurement reference and is always at location 0 in the 
display.

Positioning the X Cursor

To position the X‐Cursor within the viewer data display, click the left mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 

Positioning the Y Cursor

To position the Y‐cursor within the viewer data display, click the right mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 

Note:You can also left‐click to set the X‐cursor and right‐click to set the Y cursor in the Frame List View 
by clicking in the narrow strip on the very left side of a cell.

Time

Time differences between the cursors are displayed in the Cursor Position toolbar. To 
display the cursor position toolbar, select Toolbar from the view menu and choose Cursor 
Position.

Figure 3.51: Cursor Position Toolbar
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Locate Cursors

To quickly locate any cursor within the data viewer display, click the Go To button and 
choose the cursor to locate. You can also locate a cursor by selecting Go To from the Edit 
menu and choosing the cursor to locate. 

Figure 3.52: Locate Cursor

Go to Time Stamp

To locate a timestamp, click the Go To button and choose Timestamp.

Enter a time stamp value in the Go To Timestamp dialog and click OK. 

Figure 3.53: Go to Time Stamp

Bookmarks

Bookmarks are a convenient way to mark a point in the data viewer display by name, so 
that you can rapidly return to that point. To create a bookmark, right‐click the mouse in 
the data viewer area on a packet in which to place the bookmark.

Figure 3.54: Bookmark
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Click Bookmark from the fly out menu to open the Bookmark Comment Dialog.

Figure 3.55: Bookmark Dialog

Enter a description for the bookmark and click the Add button. Repeat for additional 
bookmarks.
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Finding a Bookmark

To find a bookmark in the data viewer display, right‐click the mouse in the sample viewer 
and select Bookmark.

Figure 3.56: Go To Bookmark Dialog Box

Highlight the bookmark to which to go, then click the Go To button, or 
double‐click the selection.

Figure 3.57: Bookmark Found Example in Data Viewer Display

Bookmark Description

To get a quick description of a displayed bookmark, position the tool tip over a bookmark. 
The name and description of the bookmark display.
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Set Time Stamp Origin

Right‐click in the sample viewer to open the fly out menu:

Figure 3.58: Bookmark Found Example in Data Viewer Display

Highlight Set Time Stamp Origin and choose either Absolute, Trigger, Current Position, or 
Based on system time.

Search

The Search menu and toolbar options permit you to examine any data capture file to 
quickly locate the packet or data pattern. To perform an initial search, select Edit > Search 

or click the   Search button to open the Search setup dialog (see Figure 3.59 on 
page 215).

Note:Only items captured in the sample file are enabled for search. 
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Figure 3.59: Search Data Pattern

You can continue to search the output file using Next Search (F3) or Previous Search (F4) 
for the same pattern, until you redefine the data capture search parameters.

Save Search Setup

After you have set up a Search configuration, you can save it as a Search configuration file 
by clicking Save. You can then use it on a different capture by clicking Load in the Search 
dialog.

Search Direction

Choose either Forward or Backward direction in which to perform the search.

Search From

Choose a starting point to begin or continue a search: Start of the sample file, 
Trigger Pointer, X Pointer, Y Pointer, or Last Found.

Search Logic

The default setting is Or Selected Items. With this setting, clicking Find Next locates all 
selected items in turn. If you choose And Selected Items, you can set a logical AND 
combination of items to find. Both options allow setting Advanced search features.
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Search For

Choose a category to search in the Search For window. Each of the search categories 
offers additional choices in the Search Items window to refine the search. Check items 
for the selected category.

Protocol Error

You can refine the search to locate packets with an error or without an error.

Data Pattern

Search for Data Pattern allows you to search for a specific Data Type, Pattern, and Length.

 Data Pattern Only
 Data Payload Length Only
 Data Pattern and Data Payload Length

Search Domain

Click the Domain button and choose a search domain from all ports or a specific port. 

Search Sub Items

When searching SCSI Command Status, you can refine the search by selecting from a list 
of Sub Items.

When you check the SCSI Command Status, the Check Condition item appears in the 
Search Items Window, if a check condition has occurred. Clicking this enables Search Sub 
Items, allowing you to refine the search by specifying Sense Key, ASC, and ASCQ.
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Display Configuration

The Analyzer ships with a default display configuration of field and viewer settings. You 
can define your own field and viewer settings for a particular testing scenario.

Sample Viewer Configuration

The Trace Viewer Configuration dialog allows you to change the following fields and 
views:

 Frame Fields
 Sequence Fields
 SCSI Command Fields
 ELS Command Fields: ELS Command, Status, Loop Init ID
 SW Command Fields: SW Command, Status
 GS Command Fields: Command/Response code, GS_Type, GS_Subtype, Status
 FICON Fields
 Additional Fields
 Text View
 Spreadsheet View

The Trace Viewer Configuration dialog allows you to change the following display 
settings:

 Field settings
 Data format
 Visible checkbox
 Byte Order alignment

 Field Header Setting
 Name
 Abbreviation
 Foreground

 Viewer Settings
 Wrap packets
 Enable tool tip

 Data Payload
 Columns in Row
 Bytes in Column

 Time Stamp Origin: Absolute, Trigger, User Defined, Based on System Time
 Time Stamp Format and Time Format
 Header Fields Appearance
 Save Display Configurations in a file
 Load Display Configuration settings from a file
 Factory Setting (Restores Default Settings)
 Font
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To customize the display, click the   Configuration button on the Viewer toolbar, 
or select Configuration > Viewer Configuration, to open the Trace Viewer Configuration 
dialog. 

Figure 3.60: Trace Viewer Configuration

Field Settings

To view a packet field, select a field from the packet field tree and check the Visible box. 
Uncheck it to hide the field. 

To change the data format of a packet field, select the field and choose a data format 
from the Format drop‐down list.
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Color

To change the color of the text in a packet field header, select a field from the packet field 
tree and click the Foreground button

Figure 3.61: Color

Choose an appropriate color and click OK.

Font

To change display fonts, click the Font button to open the Font dialog box.

Figure 3.62: Font

Choose the font, font style, and size, and click OK.
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Viewer Settings

Check the Wrap Packet box to enable the wrapping of packets in the display.

Check the Enable Tooltip box to enable tool tips for packet fields.

Data Payload

To change the length of byte fields displayed, select from the drop‐down list to display in 
the Columns in Row and Bytes in Column box.

Time Stamp Origin

Check Absolute Trig to display trigger in real time. If left unchecked, the trigger position is 
t=0 with samples before trigger shown as a (‐) number and after trigger as a (+) number, 
or check Trigger, User Defined, Based on System Time.

Same color for start time and port

Check the appropriate Time Stamp Format and Time Format.

Save/Load Settings

You can save the customized configuration settings in a *.cfg file by clicking the Save 
button and completing the Save As procedure. To load a previously saved configuration 
file, click Load and choose an appropriate file.

Port Configuration

Port Configuration allows you to configure the ports for the Analyzer and Jammer and the
sequence in which they are attached.

To view and configure the ports, select Configuration > Port Configuration.

Figure 3.63: Set Port Configuration Dialog

Select a configuration from the drop down list in the Ports Assignment column and click 
OK. See Figure 3.65 on page 221.
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Figure 3.64: Set Port Configuration Dialog

Port Calibration

The Port Calibration dialog displays the Units and Ports Input and Output Signal parameters.

Figure 3.65: Port Calibration Dialog

To display the Port Calibration dialog, select 
Configuration > Port Calibration.

Input Signals have Input Equalization.

Output Signals have Output Level, De‐emphasis Level, and Time Constant.

You can Save and Load the settings, or Restore Factory settings.
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Floating License 

Note:This feature will be applicable in the future version of the software.

To manage the license, select Configuration > License Manager.

The Floating License dialog displays the available functionality by Function, Total Ports, 
Assigned To ports, and Not Used. It also displays the Current License Configuration by 
License Type, Serial Number, Analyzer and InFusion.

Software Settings

Software Settings allow you to define template files for new Analyzer projects, to specify 
how sample files appear when opened, and to set Spec Assignment.

To perform software settings in an open sample view, select Configuration > Software 
Settings.

Figure 3.66: Software Settings Dialog General Tab
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Figure 3.67: Software Settings Trace Tab

Set the options and click OK.
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Sampling Memory Usage Optimization

The Software Settings dialog has a Sampling Memory Usage Optimization option. This Mem‐
ory Assignment (MA) feature optimizes sampling memory utilization.

If the Sampling Memory Usage Optimization Option is Checked

The system tries to use empty space in all memory banks to prevent any memory bank 
from filling completely. Each physical link is not necessarily assigned to a specific memory 
bank. The system can capture more sample data than if the MA option is unchecked, and 
sample file size is closer to the user‐defined Sampling Memory Size.

Memory Assignment efficiency varies with Port Configuration and Trigger Position:

 FPGA: The Memory Assignment feature works for a pair of ports connected to 
one FPGA, for example ports 1 and 2 (or ports 3 and 4). Memory Assignment 
does not work for two ports connected to different FPGAs, for example ports 1 
and 3.

 Triggering: Memory Assignment only starts after the trigger point. During 
pre‐trigger, each physical link is always assigned to a specific memory bank.
Post‐trigger, the system can try to use empty space in all memory banks, if you 
check the MA option. Therefore, Memory Assignment efficiency is maximum 
when Trigger Position is set to 0% (snap‐shot trigger) and is minimum when Trig‐
ger Position is set to 99% or when there is no triggering (you stop recording 
manually).

Here are examples of different Port Configurations and Trigger Positions:

 One port configuration (A‐): Sample size is user‐specified sample size.
 Two port pair configuration (A‐): Ports 1/2 and 3/4 are on the same FPGA, so 

Memory Assignment has an effect. If you use snapshot triggering, the sample 
size is near specified size.

 Two port pair configuration (A‐): If you use manual stop, Memory Assignment 
has no effect. Sample size depends on port traffic loads.

 Two port pair configuration (A‐): If trigger is set at 50%, and there is enough 
data to fill pre‐trigger, Memory Assignment has an effect. Sample size is typically 
near specified size.

 Two port pair configuration (A‐): If trigger is set at 50%, but there is not enough 
data to fill pre‐trigger, Memory Assignment has an effect. Sample size is typically 
more than half specified size, with size determined by the amount of data cap‐
tured before trigger.

 Two port pair configuration (AA): Ports 1/2 and 3/4 are not on the same FPGA, 
so Memory Assignment has no effect. If one port has heavy traffic, it may fill its 
memory bank and stop recording, resulting in smaller sample size than speci‐
fied.

NOTE 1: Checking this option does not affect the sample. It only allows larger sample 
sizes.

NOTE 2: If traffic is balanced on ports, sample size is the same whether you check or 
uncheck the Sampling Memory Usage Optimization option.
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NOTE 3: Memory Assignment depends on traffic load distribution at the time when the 
system tries to re‐assign physical links to memory banks. Therefore, if you repeat a 
capture with the same Sampling Memory Size and Segment Number parameters, the 
resulting sample size may not be the same. However, if traffic load distribution is similar, 
sample size will be similar. 

NOTE 4: The buffer status indicator shows buffer by FPGA, not by port.

If the Sampling Memory Usage Optimization Option is Not Checked

Each physical link (or logical link if MUX is enabled) is assigned to a specific memory space 
(memory bank), depending on the Sampling Memory Size and Segment Number 
parameters.

Important: If any physical link fills its memory bank, the recording process stops. Other 
memory banks will typically be less than full (and can be empty). The sample file might be 
smaller than the user‐defined Sampling Memory Size. You might even think that the 
Analyzer malfunctioned. 

Set Port Alias

Port Alias allows you to assign a meaningful name to each port to assist in interpreting the 
results displayed in the sample view.

To assign port names in an open sample view, select Configuration > Set Port Alias.

Figure 3.68: Assign Port Alias

Assign a meaningful name to each port for each unit in use and click OK. The assigned 
names replace the port numbers in the sample view.

If you elect to save the capture sample file, the assigned port names are saved together 
with the result, so that when you open the sample file later, the assigned names are 
retained.

Set As Default

If you want to set these port aliases for sample files that will be captured later, you can set 
them as default, and new samples will be opened by these default port aliases.
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External Trig Setting

The External Trig Setting dialog displays the External Trig Out Setting and External Trig In 
Setting as High Active, Low Active, or Toggle.

Figure 3.69: External Trigger Setting Dialog

To display the External Trig Setting dialog, select Configuration > External Trig Setting.

External Trig Out Setting
The Analyzer can send a Low or High external signal anytime a trigger occurs. Select the 
External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Enter the External TrigOut pulse width.

External Trig In Setting
An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

The nominal External Trigger voltage is 0.818 volts. Trigger In can work with 1 volt to 
5 volts input voltage.
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Update Sierra Device

The Update Sierra Device command allows you to update a SierraFC M164 Analyzer 
whose current version is incorrect.

1. Click Configuration > Update Sierra Device to display the Device Setup dialog. 

Figure 3.70: Device Setup Dialog with a Bad Device Status

Devices whose version is correct have an OK status in a green box. 
A device whose version is incorrect has a BAD status in a red box.

Note:You can click the ellipses (...) at the end of a file path and name to display an Open dialog, in 
which you can browse for files.

2. Click the checkbox to the left of a device with BAD status, then click Update Selected 
to begin the process that will make the Analyzer version correct.

Figure 3.71: Device Setup Dialog Beginning to Update Status of a Device
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After the update, the device must restart.

Figure 3.72: Info Dialog

Then the update is complete.

Figure 3.73: Device Setup Dialog with OK Device Status
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Set Address Alias

Address Alias allows you to assign a meaningful name to each address to assist in 
interpreting the results displayed in the sample view. To assign address names in an open 
sample view, select Configuration > Set Address Alias.

Figure 3.74: Assign Address ID

Assign a meaningful name to each address in use and click OK. The assigned names 
replace the address in the sample view, Search, filter,. and Statistical Report.

If you elect to save the captured sample file, the assigned address names are saved 
together with the result, so that when you open the sample file later, the assigned names 
are retained.

Set As Default

If you want to set these address aliases for sample files that will be captured later, you can 
set them as default, and new samples will be opened by these default address aliases. 

Connecting the SierraFC M164 to a Host System Over Ethernet

SierraFC M164 Systems are designed to connect to host PCs using a network connection, 
which allows the user to control the SierraFC M164 System from a local or remote host 
system. 

To connect via USB refer to “Connecting Via USB” on page 27.
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Configuring the System 

There are two ways of configuring a SierraFC M164 for network connectivity:

 DHCP automatically assigns an IP address. DHCP is the default.
 Static IP prompts you to enter a specific IP address.

The SierraFC M164 can be configured from the unit itself using the five buttons and the 
LCD display on the front panel of the analyzer. For additonal information, see “LCD 
Display and Button Functions for Configuring the Analyzer” on page 14. 

Dynamic Configurations 

Dynamic configuration uses DHCP (Dynamic Host Configuration Protocol). 

Under DHCP, SierraFC M164 will issue a broadcast to any DHCP Server requesting 
configuration. If a DHCP server is present on the network, it will assign an IP address, 
Subnet Mask and a default GATEWAY (a router port IP address) to the SierraFC M164. The 
Gateway port will be used by SierraFC M164 to forward packets to IP addresses that do 
not reside within the same subnet. 

When using the dynamic configuration, the front panel display will only update the IP 
address. 

The subnet mask and gateway address will remain at the last values programmed 

(000.000.000.000 by default, or whatever was last programmed in the static 
configuration). While in dynamic mode, these parameters will have actually been 
programmed within the IP STACK inside the SierraFC M164, but are not displayed in the 
LCD display. 

To change from DHCP to Static IP, you must be connected to a device using USB:

1. Select Configuration > Setup IP from the menu bar.

Figure 3.75: Configuration Menu with Setup IP Command
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Note: If you are connected to the device using Ethernet, the Configuration menu does not have the 
Setup IP command.

The IP Setting dialog appears. For IP Mode, two radio buttons are available: 
Static IP and DHCP. DHCP is the default. 

Figure 3.76: Static IP Setup Dialog

Static Configurations 

Within static configurations, SierraFC M164 must be manually programmed with an IP 
address, Subnet Mask and a default GATEWAY. 

Once SierraFC M164 has been programmed with the static network configuration, it will 
broadcast a UDP message on its own subnet stating that is on line and available for 
connection. 

Note:This broadcast is only on the subnet that includes the SierraFC M164 System. 

When the application is started on the Host PC, it will broadcast a UDP message on its 
own subnet asking all SierraFC M164s available to identify themselves. 

Note:This broadcast is only on the Host PC's subnet. 

If the Host PC and the SierraFC M164 System reside on the same subnet, they will see 
each other’s broadcasts and the application will automatically populate the Select Device 
list. 

2. To change to Static IP, click the Static IP radio button.

Enter the Static IP Address.

Enter the Subnet Mask. 

Click Update. 

The system displays a warning message. 

Click Yes to get a success message.

Click OK. The message closes and the device resets. 
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3. To change back to DHCP, in the IP setup dialog, click the DHCP radio button, then 
click Update.

Figure 3.77: Dynamic IP Setup Success Message

After you see the Warning Message, click Yes

After you see the Success Message, click OK.

Note:You can also click Reset.

Ethernet Connectivity Through a Different Subnet

If you have multiple subnets and would like to connect the Analyzer over a subnet where 
the DHCP server is on a subnet different from the host computer or the analyzer or if the 
Host PC and the SierraFC M164 System do not reside on the same subnet, they will not 
see each other automatically. The SierraFC M164 IP address must be added manually. 
Perform the following steps:

1. Launch the application and click the Ethernet radio button.

2. Click OK.

3. Click on Add Device in the Select Device dialog.
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Figure 3.78: Select Device Dialog to Add New Device

4. The Add Device with Static IP will appear. Enter the IP address to add the device.

Figure 3.79: Add New Device with Static IP Address

Once the IP address is added, the application will then send a connection request to 
that IP address to connect to the SierraFC M164 System. 

Help Menu

Help Topics

Displays online help. You can also select F1.

Update License

A current license agreement with LeCroy entitles the Analyzer owner to continued 
technical support and access to software updates as they are published on the LeCroy 
website. When you obtain a license key, from the Help menu select Update License to 
display the Select License Key File dialog box. Enter the path and filename for the license 
key, or browse to the directory that contains the license key and select the *.lic file. Click 
Open.
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Display License Information

Open a license information dialog to display a list of named features supported by the 
current software version Named features that are not enabled on your system are 
indicated by No in the Purchased column. Whether or not named features are enabled 
depends on the license key stored in your analyzer If you try to use a feature for which 
you do not yet have a license, the program displays the License Protection Message. To 
use the feature, you must purchase a license.

Check for Updates

Check whether a new software version is available. If so, you can download from the 
LeCroy web site. 
You can select to Check for updates at application startup.

About

Displays LeCroy FC Protocol Suite software version information.
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China Restriction of Hazardous Substances Table
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The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact LeCroy
Type of Service Contact

Call for technical support US and Canada: 1 (800) 909‐7112

Worldwide: 1 (408) 653‐1260

Fax your questions Worldwide: 1 (408) 727‐6622

Write a letter LeCroy

Protocol Solutions Group 
Customer Support 
3385 Scott Blvd. 

Santa Clara, CA 95054‐3115

USA

Send e‐mail psgsupport@lecroy.com

Visit LeCroy’s web site http://www.lecroy.com/
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